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Abstract

These Application Notes describe the steps for configuring an Avaya IP Office Release 10.1
solution with the AT&T IP Flexible Reach - Enhanced Features service using AVPN or
MIS/PNT transport connections. In the sample configuration, the Avaya IP Office solution
consists of Avaya Session Border Controller for Enterprise Release 7.2, Avaya IP Office
Server Edition Release 10.1, and Avaya SIP, H.323, digital, and analog endpoints.

These Application Notes complement previously published Application Notes by illustrating
the configuration screens and Avaya testing of IP Office Release 10.1 and Avaya Session
Border Controller for Enterprise Release 7.2.

The AT&T IP Flexible Reach - Enhanced Features service is one of several SIP-based Voice
over IP (VolIP) services offered to enterprises for a variety of voice communications needs.
The AT&T IP Flexible Reach service allows enterprises in the U.S.A. to place outbound local
and long distance calls, receive inbound Direct Inward Dialing (DID) calls from the PSTN,
and place calls between an enterprise’s sites.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

AT&T is a member of the Avaya DevConnect Service Provider program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe a sample configuration using Session Initiation Protocol (SIP)
trunking between an Avaya IP Office solution and the AT&T IP Flexible Reach - Enhanced
Features service using AVPN or MIS/PNT transport connections. In the sample configuration,
the Avaya IP Office solution consists of an Avaya IP Office IP500 V2, Avaya IP Office Platform
Application Server, Avaya Communicator for Windows, Avaya Communicator for Web, Avaya
SIP, H.323, digital, and analog endpoints.

Avaya IP Office is a versatile communications solution that combines the reliability and ease of
a traditional telephony system with the applications and advantages of an IP telephony solution.
This converged communications solution can help businesses reduce costs, increase productivity,
and improve customer service.

The Avaya Session Border Controller for Enterprise (Avaya SBCE) is the point of connection
between Avaya IP Office and the AT&T IP Flexible Reach - Enhanced Features service and is
used to not only secure the SIP trunk, but also to make adjustments to the SIP signaling and
media for interoperability.

The AT&T IP Flexible Reach - Enhanced Features service is one of several SIP-based Voice
over IP (VolP) services offered to enterprises for a variety of voice communications needs. The
AT&T IP Flexible Reach - Enhanced Features service allows enterprises in the U.S.A. to place
outbound local and long distance calls, receive inbound Direct Inward Dialing (DID) calls from
the PSTN, and place calls between an enterprise’s sites. The AT&T IP Flexible Reach -
Enhanced Features service utilizes AVPN* or MIS/PNT? transport service.

Note — The AT&T IP Flexible Reach - Enhanced Features service will be referred to as
IPFR-EF in the remainder of this document.

2. General Test Approach and Test Results

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.

The interoperability compliance testing focused on verifying inbound and outbound call flows
between IPFR-EF and the Customer Premises Equipment (CPE) containing the Avaya SBCE,
and Avaya IP Office (see Section 3.2 for call flow examples).

L AVPN uses compressed RTP (cRTP).
2 MIS/PNT does not support cRTP.
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The test environment described in these Application Notes consisted of:
e A simulated enterprise with the Avaya SBCE, Avaya IP Office, Avaya SIP, H.323,
digital and analog endpoints, as well as a fax machine emulator (Ventafax).
e An IPFR-EF production circuit, to which the simulated enterprise was connected via
AVPN transport.

Avaya recommends our customers implement Avaya solutions using appropriate security and
encryption capabilities enabled by our products. The testing referenced in this DevConnect
Application Note included the enablement of supported encryption capabilities in the Avaya
products. Readers should consult the appropriate Avaya product documentation for further
information regarding security and encryption capabilities supported by those Avaya products.

Support for these security and encryption capabilities in any non-Avaya solution component is
the responsibility of each individual vendor. Readers should consult the appropriate vendor-
supplied product documentation for more information regarding those products.

For the testing associated with this Application Note, the interface between Avaya systems and
the AT&T Flexible Reach service did not include use of any specific encryption features as
requested by AT&T.

Encryption (TLS/SRTP) was used internal to the enterprise between Avaya products wherever
possible.

2.1. Interoperability Compliance Testing
The compliance testing was based on a test plan provided by AT&T, for the functionality

required for certification as a solution supported on the IPFR-EF network. Calls were made
to/from the PSTN across the IPFR-EF network, to/from the CPE.

The following SIP trunking VolP features were tested with the IPFR-EF service:

e Incoming and outgoing voice calls between PSTN, the IPFR-EF service, the Avaya
SBCE, and Avaya IP Office, utilizing Avaya SIP, H.323, digital, and analog endpoints.

e Inbound/Outbound fax calls using T.38 or G.711.

e Various outbound PSTN destinations were tested including, local, long distance,
international, and toll-free.

e Requests for privacy (i.e., caller anonymity) for Avaya IP Office outbound calls to the
PSTN, as well as privacy requests for inbound calls from the PSTN to Avaya IP Office
users.

e SIP OPTIONS messages used to monitor the health of the SIP trunk from both Avaya IP

Office and AT&T.

Incoming and outgoing calls using the G.729(A & B) and G.711 ULAW codecs.
Call redirection with Diversion Header.

411 and 911 calls.

Long duration calls.

DTMF transmission (RFC 2833) for successful PSTN and Avaya IP Office menu
navigation.
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Telephony features such as hold, transfer, and conference.
Avaya IP Office Mobile twinning to a mobile phone when the associated Avaya IP Office
extension is called, as well as Mobility features such as Mobile Callback and Mobile Call
Control.
Avaya Remote Worker configuration (Avaya Communicator SIP softphone) via Avaya
SBCE.
AT&T IPFR-EF service features such as:

o Simultaneous Ring

o Sequential Ring

o Call Forward — Always

o Call Forward — Busy

o Call Forward — Ring No Answer
“Blind” and Attended transfers utilizing SIP Refer messaging.

2.2. Test Results
The test objectives stated in Section 2.1, with limitations as noted below, were verified.

1.

2.

Avaya IP Office only supports a packet size (ptime) of 20 msecs, and therefore does
not specify a ptime value in the SIP SDP (in either requests or responses) —
e Although no issues were found during testing, AT&T recommends that for
maximum customer bandwidth utilization, a ptime value of 30 should be
specified.

AT&T IPFR-EF Sequential Ringing — When the IP Office extension number
associated with the primary IPFR-EF Sequential Ringing number was answered by
Voicemail Pro, no mailbox greeting was heard. It was determined the cause of this
anomaly was caused by the initial INVITE from AT&T included the media attribute
“sendonly” and once the call was answered a re-INVITE was sent with “sendrecv”. [P
Office was unable to process this type of exchange correctly when the call was answered
by Voicemail Pro.

e This is currently being investigated by IP Office development team.

e The recommended workaround is described in Section 6.5, where Avaya SBCE

will convert the media attribute from “sendonly” to “sendrecv”.

SIP OPTIONS — AT&T IPFR service is configured to send SIP OPTIONS messages
with Max-Forwards header equal to 0. This is by design from AT&T. Avaya SBCE
responded correctly with “483 Too Many Hops”. However, AT&T considers this an
acceptable response to keep the trunk in service.

Inbound Super Group 3 fax calls — Avaya IP Office may not renegotiate to T.38 for
inbound fax calls if both fax devices support Super Group 3 (SG3) speeds. If the SG3
connection is fully established at the beginning of the call, the CPE fax device may not
negotiate down to G3 speeds and IP Office will not detect the G3 tones necessary for
T.38. Setting the IP Office SIP Line Fax Transport Support to “T.38 Fallback™ will allow
IP Office to renegotiate to G.711 in the event the SG3 fax machine does not negotiate
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down to G3 speeds. See Section 5.5.6. Since T.38 is the preferred method, if the CPE
device supports SG3 speeds (33600 bps), the recommendation is to also disable SG3 on
the CPE fax device if possible

5. Emergency 911/E911 Services Limitations and Restrictions — Although AT&T
provides 911/E911 calling capabilities, AT&T does not warrant or represent that the
equipment and software (e.g., IP PBX) documented in these Application Notes will
properly operate with AT&T IP Flexible Reach to complete 911/E911 calls; therefore, it
is the customer’s responsibility to ensure proper operation with the equipment/software
vendor.

While AT&T IP Flexible Reach services support E911/911 calling capabilities under
certain Calling Plans, there are circumstances when the E911/911 service may not be
available, as stated in the Service Guide for AT&T IP Flexible Reach found at
http://new.serviceguide.att.com. Such circumstances include, but are not limited to,
relocation of the end user’s CPE, use of a non-native or virtual telephone number, failure
in the broadband connection, loss of electrical power, and delays that may occur in
updating the Customer’s location in the automatic location information database. Please
review the AT&T IP Flexible Reach Service Guide in detail to understand the limitations
and restrictions.

2.3. Support

For more information on the AT&T IP Flexible Reach service visit:
http://www.business.att.com/enterprise/Service/voice-services/null/sip-trunking/

AT&T customers may obtain support for the AT&T IP Flexible Reach service by calling (877)
288-8362.

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. In the United States, (866) GO-AVAYA (866-462-8292) provides
access to overall sales and service support menus.

DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 70f73
SPOC 4/16/2018 ©2018 Avaya Inc. All Rights Reserved. IPO101SBC72FR


http://new.serviceguide.att.com/
http://www.business.att.com/enterprise/Service/voice-services/null/sip-trunking/
http://support.avaya.com/

3. Reference Configuration

Note — Documents used to provision the test environment are listed in Section 11. References to
these documents are indicated by the notation [x], where x is the document reference number.

The reference configuration used in these Application Notes is shown in Figure 1 below and
consists of the following components:

e Auvaya IP Office provides the voice communications services for a particular enterprise site.
In the reference configuration, Avaya IP Office runs on the IP 500 V2 platform. This solution
is extensible to the Avaya IP Office Server Edition platform as well.

e Avaya endpoints are represented with an Avaya 9608 H.323 Deskphone, an Avaya 9508
Digital Telephone, an Avaya 6211 Analog Telephone, an Avaya 1140E SIP Deskphone, as
well as Avaya Communicator for Windows, and Avaya Communicator for Web. Fax
endpoints are represented by PCs running Ventafax emulation software connected by modem
to an Expansion System analog port.

e Voicemail Pro (running on the Application Server) provided the voice messaging capabilities
in the reference configuration. This solution is extensible to the Avaya IP Office embedded
voice mail as well.

e In the reference configuration, IP Office interface “LAN 1” is connected to the private CPE
network (the “LAN 2” interface is not used).

e Avaya Session Border Controller for Enterprise running on VMware platform. This solution
is extensible to other Avaya Session Border Controller for Enterprise platforms as well.

e TLS/5061 is the recommended transport protocol/port to use on the Avaya IP Office LAN1
connection to the Avaya SBCE Al interface. However, TCP/5060 may be used for this
connection if desired.

e The AT&T IPFR-EF service requires the following SIP trunk network settings between the
Avaya SBCE and the IPFR-EF Border Element:

o UDP transport using port 5060
o RTP port ranges 16384-32767

e AT&T provided the inbound and outbound access numbers (DID and DNIS) used in the
reference configuration. Note that the IPFR-EF service may deliver 10 or 7 digits in the SIP
Invite R-URI depending on the circuit order provisioning. In the reference configuration, the
IPFR-EF service delivered 10 digits.

e |P Office and the Avaya SBCE used in the reference configuration were deployed using the
following configuration.

o IP Office LANL interface connected to the CPE private network.
o Avaya SBCE Al interface connected to the CPE private network.
o Avaya SBCE B2 interface connected to the AT&T IPFR-EF network router.

e An Avaya Remote Worker endpoint (Avaya Communicator for Windows) was used in the
reference configuration. The Remote Worker endpoint resides on the public side of an Avaya
SBCE (via a TLS connection), and registers/communicates with IP Office as though it was
an endpoint residing in the private CPE space.
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document. Refer to [5] for information on Remote Worker deployments.

Note — The configuration of the Remote Worker environment is beyond the scope of this

AT&T AT&T AVPN or MIS/PNT

Transport Network

IP Flexible Reach —
Enhanced Features Service
192.168.38.69

[

? |
|
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|
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| Internet
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Figure 1: Avaya Interoperability Test Lab Configuration
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3.1. Call Flows

To understand how inbound and outbound AT&T IPFR-EF service calls are handled by Avaya IP
Office, four basic call flows are described in this section.

3.1.1. Inbound

The first call scenario illustrated in the figure below is an inbound AT&T IPFR-EF service call
that arrives on Avaya IP Office, which in turn routes the call to a hunt group, phone or a fax
endpoint.

A PSTN phone originates a call to an IPFR-EF service number.

The PSTN routes the call to the AT&T IPFR-EF service network.

The AT&T IPFR-EF service routes the call to the Avaya SBCE.

The Avaya SBCE performs SIP Network Address Translation (NAT) and any specified
SIP header modifications, and routes the call to Avaya IP Office.

5. Avaya IP Office applies any necessary digit manipulations based upon the DID and
routes the call to a hunt group, phone or a fax endpoint.

—2
@-1»

el A =

Reach Enhanced
Features

PSTN
Phone1
3
Y
Avaya
SBCE
|
4
Y
Avaya
ﬁ¢5 IP Of%ce

Figure 2: Inbound AT&T IPFR-EF Call
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3.1.2. Outbound

The second call scenario illustrated in the figure below is an outbound call initiated on Avaya IP
Office for delivery to AT&T IPFR-EF service.

1.

2.

ok~

An Avaya IP Office phone or fax endpoint originates a call to an AT&T IPFR-EF service
number for delivery to PSTN.

Avaya IP Office applies any necessary origination treatment (verifying permissions,
determining the proper route, selecting the outgoing trunk, etc.) and sends the call to the
Avaya SBCE.

The Avaya SBCE performs SIP Network Address Translation (NAT) and any specified
SIP header modifications, and routes the call to the AT&T IPFR-EF service.

The AT&T IPFR-EF service delivers the call to PSTN.

PSTN delivers the call to a phone or fax endpoint.

-@4—\AT&T IP Flexible
-fh— Reach Enhanced
Features

PSTN
Phone1

Avaya
ﬁ =% |p Office

Phone

Figure 3: Outbound Call to AT&T IPFR-EF
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3.1.3. Call Forward

The third call scenario illustrated in the figure below is an inbound AT&T IPFR-EF service call
destined for an Avaya IP Office station that has set Call Forwarding to an alternate destination.
Without answering the call, Avaya IP Office redirects the call back to the AT&T IPFR-EF
service for routing to the alternate destination.

Note — AT&T requires the Diversion header be used when a call is redirected to AT&T IPFR-EF
service (See Section 5.5.5).

1. Same as the first call scenario in Section 3.2.1.

2. Because the Avaya IP Office phone has set Call Forward to another AT&T IPFR-EF
service number, Avaya IP Office initiates a new call back out to the AT&T IPFR-EF
service network. This new SIP INVITE will contain a Diversion Header.

3. The AT&T IPFR-EF service places a call to the alternate destination and upon answer,
Avaya IP Office connects the calling party (PSTN Phone) to the target party (Target
Phone).

Note — The IPFR-EF service offers similar Call Forwarding features that allow users to predefine
alternate call destinations based on Ring-No-Answer, Busy, Not Reachable, or Unconditional

criteria.
@_1 » Alternate 43@
-3 Destination
PSTN PSTN
Phone1 Phone2
-+ Avaya
—2P IP Office
Phone with
Call Forward
Figure 4: Call Forward
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3.1.4. Coverage to Voicemail
The call scenario illustrated in the figure below is an inbound call that is covered to VVoicemail.

In the reference configuration, the Voicemail system used is Voicemail Pro.

1. Same as the first call scenario in Section 3.2.1.
2. The Avaya IP Office phone does not answer the call, and the call covers to Voicemail

Pro.

DDT; Reviewed:
SPOC 4/16/2018

Phone1

Reach Enhanced
Features

PSTN

Avaya
IP Office

A |
2 1
|'Y

Voicemail Pro (g o |

Phone

Figure 5: Coverage to Avaya IP Office Voicemail
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4. Equipment and Software Validated
Table 2 shows the equipment and software used in the sample configuration.

Avaya IP Telephony Solution Components

Equipment

Software

Avaya Session Border Controller for
Enterprise

Release 7.2.1.0-05-14222

Avaya IP Office IP500 V2
= [P Office
= Avaya IP Office TCM 8
= Avaya IP Office COMBO06210/ATM4

Release 10.1.0.1.0 build 3
Release 10.1.0.1.0 build 3
Release 10.1.0.1.0 build 3

Avaya IP Office Platform Application Server
= Voicemail Pro
= Avaya WebRTC Gateway
= Avaya one-X® Portal for IP Office

Release 10.1.0.1.0 build 3
Release 10.1.0.1.0 build 3
Release 10.1.0.1.0 build 3

Avaya IP Office Manager

Release 10.1.0.1.0 build 3

Avaya 9611SW IP Deskphone (H.323) Release 6.6506
Avaya 1140E IP Deskphone (SIP) Release 04.04.23
Avaya 9508 Digital Telephone Release 0.60

Avaya Communicator for Windows

Release 2.1.4.256

Avaya Communicator for Web

Release 1.0.18.1124

Analog Fax device

Ventafax 7.9

Table 1: Equipment and Software Tested

Compliance Testing is applicable when the tested solution is deployed with a standalone 1P
Office 500 V2, and also when deployed with all configurations of IP Office Server Edition. Note
that IP Office Server Edition requires an Expansion IP Office 500 V2 to support analog or digital

endpoints or trunks.
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5. Avaya IP Office Configuration

IP Office is configured via the IP Office Manager program. For more information on IP Office
Manager, consult reference [2]. From the IP Office Manager PC, select Start - Programs 2>
IP Office = Manager to launch the Manager application. Navigate to File > Open
Configuration (not shown), select the proper Avaya IP Office system from the pop-up window,
and log in using the appropriate credentials.

B Select IP Office - u] X

Name IP Address Type  Version Edition
Release 10.1
SIL-ATT 10641970 IP500V2 10.1.0.1.0build3 IP Office

IP Office: SIL-ATT (IP 500 v2)

Service User Name  [Administrator ‘

Service User Passwort d [sessseeseearenacees |

TCP Discovery Progress

Unit/Broadcast Address

10.64.19.70 - Refresh Cancel

The appearance of the IP Office Manager can be customized using the View menu. In the
screens presented in this section, the View menu was configured to show the Navigation pane on
the left side, the Group pane in the center, and the Details pane on the right side.

5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require the IP Office system
to be licensed appropriately. If a desired feature is not enabled or there is insufficient capacity,
contact an authorized Avaya sales representative.

To verify that there is a SIP Trunk Channels License with sufficient capacity, click License in
the Navigation pane. Confirm a valid SIP Trunk Channels license with sufficient Instances
(trunk channels). If Avaya IP Telephones will be used as is the case in these Application Notes,
verify the Avaya IP endpoints license.
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License Remote Server
License Mode License Mormal
Licensed Version 10.0
PLDS File Status ~ Valid
Feature Instances Status Expiration Date Source ~ Add...
IPSec Tunnelling 1 Valid Mewver PLDS MNodal
Power User 384 Valid Mewer PLDS Modal Remove
Customer Service Agent 100 Valid Mever PLDS Modal
Customer Service Supervisor 100 Valid Mewver PLDS Medal
Avaya IP endpoints 384 Valid Mever PLDS Modal
| 1PS00 Vinice Metworking Channels 32 Valid Meyver ELOS Memdal
SIP Trunk Channels 128 Valid Mewver PLDS Medal
IP500 Univerzal PRI (Additional cha... 100 Valid Mewver PLDS Modal
CTI Link Pro 1 Valid Mewer PLDS Modal
Wave User 16 Valid Mever PLDS Modal
3rd Party IP Endpeints 384 Valid Mewver PLDS Medal
Essential Edition 1 Valid Mewer PLDS Modal

In the sample configuration, looking at the IP500 V2 from left to right, the first module isa TCM
8 Digital Station Module. This module supports BCM / Norstar T-Series and M-Series
telephones. The second module is a COMBO6210/ATM4 module. This module is used to add a
combination of ports to an IP500 V2 control unit and is not supported by IP500 control units.
The module supports 10 voice compression channels. Codec support is G.722, G.711, G729A
and G.723 with 64ms echo cancellation. The “Combo” card will support 6 Digital Station ports
for digital stations in slots 1-6 (except 3800, 4100, 4400, 7400, M and T-Series), 2 Analog
Extension ports in slots 7-8, and 4 Analog Trunk ports in slots 9-12.

IP Offices | Control Unit = IP 500 V2 B v
lﬁ BOOTP (22) Dev Mo. DevType Unit
4+ Operstor (3) =1 1P 500 V2
2 SIL-ATT -2 TeMs Device Number |1 |
% System (1) 3 COMBOG2IO/ATMA
T Line (8) s / Unit Type [Ipspovz |
<= Control Unit (3)
e e Version 101070 build 3 |
~§  User(25)
3 Wosker) Serial Number [o0e07058¢33 |
9% Short Code (79) 10.64.19.70
@ Sendice (0] Unit IP Address | |
ol RAS (1) Intercoennect Mumber |D |
e Incoming Call Rou
8 WAN Port (0) Module Number [Contral Unit |
-~ Directory (0)
2 T Denfil o

5.2. TLS Management

For the compliance test, the signaling on the SIP trunk between IP Office and the Avaya SBCE
was secured using TLS. Testing was done using identity certificates signed by a local certificate
authority SystemManager CA. The generation and installation of these certificates are beyond
the scope of these Application Notes. However, once the certificates are available they can be
viewed on IP Office in the following manner.

To view the certificates currently installed on IP Office, navigate to File = Advanced =
Security Settings. Log in with the appropriate security credentials (not shown). In the Security
Settings window, navigate to Security = System and select the Certificates tab.
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To verify the identity certificate, locate the Identity Certificate section and click View to see the
details of the certificate.

Security Settings System: SIL-ATT

=5 Security System Details _Unsecured Interfaces  Cerfficates
i General Identity Certificate
2 System (1)

56 Services (7) Offer Certificate =
i Rights Groups (17) Offer ID Certficate Chain [
+-gry Service Users (11) lesued To: ip500v2 avayalab.com

Set View Regenerate
Certificate Bxpiration Waming (days) 60 =
[] Use dfferent Identity Certificate for Telephony

Received Certificate Checks M -
[Management Intefaces) s

Received Cerificate Checks M -
(Telephony Endpoints) L=

Trusted Certificate Store
Installed Certfficates

System Manager CA
Symartec Class 3 Secure Server CA - G4

5.3. System Settings

This section illustrates the configuration of system settings. Select System in the Navigation
pane to configure these settings. The subsection order corresponds to a left to right navigation of
the tabs in the Details pane for System settings. For all of the following configuration sections,
the OK button (not shown) must be selected in order for any changes to be saved.

5.3.1. LAN Settings

In the sample configuration, LANL1 is used to connect IP Office to the enterprise network. To
view or configure the IP Address of LAN1, select the LANL1 tab followed by the LAN Settings

tab. As shown in Figure 1, the IP Address of IP Office is 10.64.19.70. Other parameters on this
screen may be set according to customer requirements.

IP Offices | = SIL-ATT

System LANT 1aN2  DNS

+3§ 800TP (22 Voicemail Telepheny Directory Services System Events SMTP  SMDR  VCM  VolP
#-4% Operator (3)

SIL-ATT LAN Settings  volP Metwaork Topology
' Systemn (1)

VolP Security Contact Center

i s SIL-ATT IP Address 0 64 19 70

-7 Line (8)

- Control Unit (3) 1P Mask 255 . 255 . 255 0

+-4 Extension (23)

; . 0 0 0 0

+= User (25) Primary Trans. IP Address

25§ Group (5] RIP Mode None )
i1 @% Short Code (79)

8B Service (0) [ Enable NAT

-l RAS (1)

@ Incoming Call Row |~ Number Of DHCP [P Addresses 200 |2
-~ WAN Port (0) DHCP Mode

Directory (0]
LD T prefie @ O server O Client O Dialln @ Disabled
{8} Firewall Profile (1)

Advanced

Select the Vol P tab as shown in the following screen. The H323 Gatekeeper Enable parameter
is checked to allow the use of Avaya IP Telephones using the H.323 protocol, such as the Avaya
9808 used in the sample configuration. The SIP Registrar Enable parameter is checked to allow
Avaya 1140E and Avaya Communicator usage. The SIP Trunks Enable parameter must be
checked to enable the configuration of SIP trunks to AT&T. The SIP Domain Name and SIP
Registrar FQDN may be set according to customer requirements. If desired, the RTP Port
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Number Range can be customized to a specific range of receive ports for the RTP media paths
from Avaya SBCE to IP Office. The defaults are used here.

SIL-ATT

W SIL-ATT

-4 Line (8)
i-<2 Control Unit (3)
- Extension (23)
i-f§ User(23)
-3 Group (5)
- BX Short Code (79)

Service (0)
RAS (1)

WAN Port (0)
Directory (0)

) Time Profile (0
Firewall Profile (1)
IP Route (4)
Account Code (0)
 License (34)

: Tunnel (0)

] ﬁ‘, User Rights (8)
'K ARS (6)

-8 Location (2)

Incorming Call Rou

System LANT 1AMz DNS
LAN Settings VolP

H.323 Gatekeeper Enable
[] Auto-create Extension

H.323 Signaling over TLS

SIP Trunks Enable

SIP Registrar Enable

Voicemail Telephony Directory Services System Events

Network Tepology

Auto-create User

[] Auto-create Extension/User

SIP Domain Name

SIP Registrar FODN

Layer 4 Pratacal

SMTP  SMDR VCM

[] H.323 Remote Extension Enable

VolP VolIP Security Contact Center

[ sIP Remate Extension Enable

|s|hpn.avaylah.(um

|\p5DDv2.avay\ab.(Dm

upp
TCP
TLS

UDP Port 5060
TCP Port 5060

TLSPort 3061

Challenge Expiration Time (sec)

10

‘-3 Authorization Cods

RTP
Port Number Range

Minimum 49152 Maximum 53246

Scroll down to the Keepalives section, and set the Scope to RTP-RTCP. Set the Periodic
timeout to 30 and the Initial keepalives parameter to Enabled. These settings will cause IP
Office to send RTP and RTCP keepalive packets starting at the time of initial connection and
every 30 seconds thereafter if no other RTP or RTCP traffic is present. This facilitates the flow
of media in cases where each end of the connection is waiting to see media from the other, as
well as helping to keep ports open for the duration of the call.

IP Office can be configured to mark the Differentiated Services Code Point (DSCP) in the IP
Header with specific values to support Quality of Service policies. In the sample configuration
shown below, IP Office will mark SIP signaling with a value associated with “Assured
Forwarding” using DSCP decimal 28 (SIG DSCP parameter). IP Office will mark the RTP
media with a value associated with “Expedited Forwarding” using DSCP decimal 46 (DSCP
parameter). See Section 2.2 for limitations with IP Office Server Edition. This screen enables
flexibility in IP Office DiffServ markings (RFC 2474) to allow alignment with network routing
policies, which are outside the scope of these Application Notes. Other parameters on this screen
may be set according to customer requirements

Keepalives

Scope RTP-RTCP ~ | Periedic timeout

Initial keepalives Enabled v

DiffServ Settings

B8 3| DSCP(He B8 |5 VideoDSCP (Hex) FC 5 DSCP Mask (Heq 88 2| SIG DSCP (Hex)

46 3| Dscp 46 2 Video DSCP 63 3| DSCP Mask 34 +| SIG DSCP
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Select the Network Topology tab as shown in the following screen. The Firewall/NAT Type is
set to Unknown in the sample configuration. The Public IP Address and Public Port sections
are not used for the AT&T IPFR-EF SIP trunk service connection.

SIL-ATT B v
System LANT Lan2  DNS Voicemail Telephony Directory Services System Events SMTP  SMDR  VCM  VolP VolP Security Contact Center
- LAN Settings WolP  Network Topology
) - Network Topology Discovery
19 Line (3) STUN Server Address 0.0.00 STUN Port 3478 z
#-=» Control Unit (3)
+-4p Extension (23) Firewall/NAT Type Unknown ~
+-§  User (25)
58 Group (5) Binding Refresh Time (sec) 60
% Short Code (79)
@ Service (0) Public [P Address 0 0 0 0 Run STUN Cancel
1ol RAS (1)

2 @ Incoming Call Row Public Port

4B WAN Port (0] 0 =
== Directory (0) upP -
£ T -

£ "1 Time Profile (0) -

N TCP 0 S

-8} Firewall Profile (1)

-l IP Route (4) Tis 0 =

- Account Code (0)
Q. License (34)

i~ i Tunnel (0)

o H

Lece Dinkeo [0

[1 Run STUN en startup

5.3.2. Voicemail Settings

To view or change voicemail settings, select the Voicemail tab as shown in the following screen.
The settings presented here simply illustrate the sample configuration and are not intended to be
prescriptive. The Voicemail Type in the sample configuration is Voicemail Lite/Pro. The
Voicemail IP Address in the sample configuration is 10.64.19.69, the IP address of the
Application Server running the Voicemail Pro software.

*

IP Offices |

- R BOOTP (22
-5+ Operator (3)
SIL-ATT

SIL-ATT &

System LANT LAN2 DNS  Voicemail Telephony Directory Services System Events SMTP  SMDR VCM  VolP  VolP Security Contact Center

Voicemail Type Vioicemail Lite/Pro ~

Messages Button Goes To Visual Voice
Outcalling Control

Voicemail Destination

[ Line(8)

Control Unit (3) Voicemail IP Address 0. 64 . 19 . &9
#-4 Extension (23)
5§ User23) Backup Voicemail [P Address | 0 0 0 0
+ ﬁ Group (3 Voicemail Channel Reservation
#-@% Short Code (79)
@ Service (0) Unreserved Channels
ol RAS (1) = =
@ Incoming Call Rour|  Auto-Attendant 10 2] VoiceRecording (10 2| Mandatory Voice Recording 0

g WAN Port (0)
@& Directory (0)

Announcements 10 +| Mailbox Access |10

In the sample configuration, the “Callback” application of Avaya Voicemail Pro was used to
allow Voicemail Pro to call out via the SIP Line to AT&T IPFR-EF when a message is left in a
voice mailbox. The SIP Settings shown in the screen below enable IP Office to populate the SIP
headers for an outbound “callback” call from Voicemail Pro, similar to the way the fields with
these same names apply to calls made from telephone users (e.g., see Section 5.6).

SIP Settings
SIP Display Name (Alias)
Anonymous O

DDT; Reviewed:
SPOC 4/16/2018

Solution & Interoperability Test Lab Application Notes

19 of 73

©2018 Avaya Inc. All Rights Reserved. IPO101SBC72FR



5.3.3. System Telephony Configuration

To view or change telephony settings, select the Telephony tab and Telephony sub-tab as
shown in the following screen. The settings presented here simply illustrate the sample
configuration and are not intended to be prescriptive. In the sample configuration, the Inhibit
Off-Switch Forward/Transfer parameter is unchecked so that call forwarding and call transfer
to PSTN destinations via the AT&T IPFR-EF service can be tested. That is, a call can arrive to
IP Office via the AT&T IPFR-EF service and be forwarded or transferred back to the PSTN with
the outbound leg of the call using the AT&T IPFR-EF service. The Companding Law
parameters are set to U-Law as is typical in North American locales. Other parameters on this
screen may be set according to customer requirements.

IP Offices |

SIL-ATT [, v | =<
: ‘S gOOTtP (2(23]] System LANT LAN2 DNS Voicemail Telephony  Directory Services System Events SMTP  SMDR  VCM  VolP VolP Security Contact Center
¢ Operator
o SIL-ATT Telephony  Park & Page Tones & Music RingTones SM  CallLog TUI
= System (1) N
<=9 SIL-ATT Analogue Extensions Companding Law
-4 Line (8) Switch Line
<= Control Unit (3) Default Outside Call Sequence Normal ~
-4 Extension (23) .
9§ User(zs) Default Inside Call Sequence Ring Type 1 v ® U-Law ® U-Law Line
238 Group (5) ' :
4+ 8% Short Code (79) Default Ring Back Sequence Ring Type 2 ~ o at o
-Law -Law Line
B Service () Restrict Anclogue Extension Ringer Voltage 0
oy RAS (1)
=@ Incoming Call Row
~Ef) WAN Port (0) Dial Delay Time (sec) n - [ Dss status
% Directory (0) Auto Hold
~£7 Time Profile (0) Dial Delay Count 0 = Mo e
=@ Firewall Profile (1) ] Dial By Narme
=-ll IP Route (4) Default No Answer Time (sec) 15 -
-~ Account Code (0) Show Account Code
W License (34) Held Timeout (sec) 0
i T 1 (0 [] Inhibit Off-Switch Forward/ Transfer
S Lunrel @) Park Timeaut (sec) 200
-5 User Rights (8)
g ARS (6) [] Restrict Netwerk Interconnect
5 B Location (2 Ring Delay (s=c) 5
p Matm_” @ Include location specific information
% Authorization Codh | g Priority Promotion Time (sec) Disabled
[] Drop External Only Impromptu Conference
Default Currency uso ~
[ Visually Differentiate External Call
Default Name Priority Favor Trunk ~
[ Unsupervised Anslog Trunk Disconnect Handling
Media Connection Preservation Disabled ~
High Quality Conferencing
Phone Failback Manual ~ .
Digital/Analogue Auto Create User
Login Code Complexity o
Directory Overrides Barrin,
[ Enforcement Y 9
Minimum length la [ Advertise Callee State To Internal Callers
[ I [ Internal Ring on Transfer v
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5.3.4. System Codecs Configuration

To view or change system codec settings, select the VVoIP tab. On the left, observe the list of
Available Codecs. In the example screen below, which is not intended to be prescriptive, the
parameter next to each codec is checked, making all the codecs available in other screens where
codec configuration may be performed (such as the SIP Line in Section 5.5). The Default Codec
Selection area enables the codec preference order to be configured on a system-wide basis, using
the up, down, left, and right arrows. By default, all IP (SIP and H.323) lines and extensions will
assume the system default codec selection, unless configured otherwise for the specific line or
extension. The RFC2833 Default Payload parameter is set to 100, the value preferred by

AT&T.

IP Offices |

= SIL-ATT

[ v

£ R BOOTP (22)
f i/ Operator (3]
=y SIL-ATT
* System (1)
559 SIL-ATT
-F5 Line (8)
<= Control Unit (3)
-y Extension (23)
+-§  User (25)
45§ Group (5)
+- 8% Short Code (79)
4B Service (0)
oy RAS (1)
+e Incoming Call Rou
48 WAN Port (0)
#% Directory (0)
?T\me Profile (0)

e

Firewall Profile (1)
-ll IP Route (4)
- Account Code (0)
% License (34)

4]

System LANT LAN2 DNS Woicemail Telephony Directory Services System Events SMTP  SMDR  VCM
Ignore DTMF Mismatch For Phones O
Allow Direct Media Within MAT Location [

RFC2833 Default Payload 100
Available Codecs Default Codec Selection
Unused Selected
BA 6.711 ULAW 64K G711 ALAW 64K EESY 5.722 64K
711 ALAW 84K (5.723.1 6K3 MP-MLCQ G711 ULAW 64K
722 64K 5.729(a) 8K CS-ACELP
(.729(a) 8K C5-ACELP
G.723.1 6K3 MP-MLQ

WolP Security Contact Center

5.3.5. VoIP Security

For the compliance test, SRTP was used internal to the enterprise wherever possible. To view or
configure the media encryption settings, select the VoIP Security tab. Set the Media drop-down
menu to Preferred to have IP Office attempt use encrypted RTP for devices that support it and
fall back to RTP for devices that do not support encryption. Under Media Security Options,
select RTP for the Encryptions and Authentication fields. Under Crypto Suites, select
SRTP_AES_CM_128 SHA1 80 and SRTP_AES_CM 128 SHAZ1 32. Click OK to commit

(not shown).
IPOffices | = SIL-ATT = v
,F BOOT: (2(23]] System LANT LANZ DNS Voicemail Telephony Directory Services  System Events SMTP SMDR  VCM VolIP Security  Contact Center
perator
L-ATT " .
2 System (1) Media Preferred v [ Strict SIPS
' SIL-ATT
1 Line (8)
£ Control Unit (3)
+ & B::nf:mnﬂ(lal Media Security Options
0§ User(25) Encrytions RTP
£3 ﬂ Group (5)
o-@% Short Code (79) [ rrce
4B Service (D) Authentication RTE
ol RAS (1)
H " RTCP
| Call R
\:.-:Nmézi (DE) o Replay Protection
a2 Directory (0) SRTP Window Size |5‘1
* Time Profile (0) Crypto Suites
‘FP";"D“:'::(;T”E M SRTP_AES_CM_128 GHAT_80
Account Code (0) SRTP_AES_CM_128_SHA1_32
= License (34)
- Tunnel (0)
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5.4. IP Route

In the sample configuration, IP Office LAN1 port is physically connected to the local area
network switch at the IP Office customer site. The default gateway for this network is
10.64.19.1. The Avaya SBCE resides on a different subnet and requires an IP route to allow SIP
traffic between the two devices. To add an IP route, right-click IP Route from the Navigation
pane, and select New (not shown). To view or edit an existing route, select IP Route from the
Navigation pane, and select the appropriate route from the Group pane. The following screen
shows the Details pane with the relevant route using Destination LANL.

IP Offices |

B

10.0.0.0

ef -t X v <

=R BOQTP (22)
4% Operator (3)
% SIL-ATT
-5 System (1)
) SIL-ATT
&-F4 Line (8)
-2 Control Unit (3)
23)

=-@X Short Code (79)
@ Service (0)
(ol RAS (1)

IP Route

IP Address

1P Mask

Gateway |P Address
Destination

Metric

[ Proxy ARP

-9 Incoming Call Rou
&2 WAN Port (0)
-4 Directory (0)
£ Time Profile (0)
i@ Firewall Profile (1)
=il 1P Route (4)
-l 192000

5.5. SIP Line

The following sections describe the configuration of a SIP Line. The SIP Line terminates the
CPE end of the SIP trunk to the AT&T IPFR-EF service.

The recommended method for creating/configuring a SIP Line is to use the template associated

with the provisioning described in these Application Notes. The template is an .xml file that can
be used by Avaya IP Office Manager to create a new SIP Line for SIP trunking with the AT&T
IPFR-EF service. Follow the steps in Section 5.5.2 to create a SIP Trunk from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

IP addresses

SIP Credentials (if applicable)

SIP URI entries

Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary,
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration as shown in Sections 5.5.3 — 5.5.8.

In addition, the following SIP Line settings are not supported on Basic Edition:
SIL Line — Originator number for forwarded and twinning calls
Transport — Second Explicit DNS Server

SIP Credentials — Registration Requirements
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e SIP Advanced Engineering

Alternatively, a SIP Line can be created manually. To do so, right-click Line in the Navigation
Pane and select New > SIP Line. Then, follow the steps outlined in Sections 5.5.3 - 5.5.8.

5.5.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format.
These XML templates do not include sensitive customer specific information and are
therefore suitable for distribution. The XML format templates can be used to create SIP
trunks on both IP Office Standard Edition (IP500 V2) and IP Office Server Edition systems.
Alternatively, binary templates may be generated. However, binary templates include all the
configuration parameters of the Trunk, including sensitive customer specific information.
Therefore, binary templates should only be used for cloning trunks within a specific
customer’s environment.

Step 1 - Copy a previously created template file to a location (e.g., \temp) on the same computer
where IP Office Manager is installed.

Step 2 - Import the template into IP Office Manager. From IP Office Manager, select Tools =
Import Templates in Manager.

File Edit View | Tools | Help

|EfE e

SIL-ATT

IP Office ' = SIL-ATT v <
Export »

SCN Service User Management System LAN1 LANZ DNS  \Voicemail Telephony DirectoryServices System Events SMTP SMDR VCM  VolP

Busy on Held Validation MName ‘S\L-ATF Locale United States (US Englist

MSN Configuration Location 2SI

Print Button Labels Contact Information

Import Templates in Manager

Set contact information to place System under special control

se Migration
ode (78] ‘ ‘

-4 WAN Port (0)

Step 3 - A folder browser will open (not shown). Select the directory used in Step 1 to store the
template(s) (e.g., \temp). In the reference configuration, template file IPO101SBC72FR.xml was
imported. The template files are automatically copied into the IP Office default template
location, C:\Program Files\Avaya\lP Office\Manager\Templates.

Step 4 - After the import is complete, a final import status pop-up window will open stating
success or failure.

Template Provisioning X

Successfully imported templates to IP Office Manager from
Ch\Temp
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5.5.2. Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation Pane, and
hover over New from Template, and select Open from file.

2. Navigate to C:\Program Files\Avaya\lP Office\Manager\Templates.

Mew
Cut
Copy
Paste
Delete

Validate

Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+Del

Mew from Template

4 Open from file

Show In Groups

Customize Columns...

the file type, find the template, and click Open.

Select *.xml as

Orgenize *  New folder

# Quick access
[ Desktop

2| Documents
& Downloads

=] Pictures.

<« « A [ |5 ThisPC 5 Avays eSOE(C) » Program Files (x36) » Avaya »

IP Office > Manager » Templates

Q Name

2] New-Templatexml

59 AM XML Document

@ | Search Templates P

B2 M @

File name: | New-Template.xml

v| Template Files (*xml) v

The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 2).

Line Mumber

1
b T
. 2

Line Type

IP Office Line
IP Office Line
SIP Line

Line SubType

WebSocket Server SCH
WebSocket Server SCH

Once the SIP Line is created, verify the configuration of the SIP Line with the
configuration shown in Sections 5.5.3 — 5.5.8.
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5.5.3. SIP Line - SIP Line tab

The SIP Line tab in the Details pane is shown below for Line Number 20, used for the SIP
Trunk to AT&T IPFR-EF. Note, if no SIP Line exists, right click on the Line item in the

Navigation pane and select New = SIP Line (not shown). In the reference configuration, SIP
Line 4 was created. The SIP Line form is completed as follows:
e |ITSP Domain Name: Set to the IP address of the Avaya SBCE Al interface (e.g.,
10.64.91.40).
e In Service and Check OOS: These boxes are checked (default).
o Note that the Out Of Service (OOS) option is used in conjunction with SIP

e Refresh Method: Set to Re-Invite, as AT&T does not support UPDATE.

OPTIONS.

e Timer (sec): Set to 1800.
e Incoming Supervised Refer: Set this field to Always to enable Avaya IP Office to

accept REFER sent by the network during a transfer scenario.

e Outgoing Supervised Refer: Set this field to Always to enable Avaya IP Office to use
REFER (with Replaces) for station initiated call transfer scenarios back to PSTN.

e Outgoing Blind Refer: Optional. Enable this option to support Refer (without Replaces)
for “Blind” (unattended) transfers (e.g., transfer-to party is still ringing when the transfer
operation is completed). If this feature is not enabled then Refer (with Replaces) will be
used. Note — This feature is only supported with SIP telephones.

e Use the default values for the other fields.

e Click OK (not shown).

IP Offices |

= SIP Line - Line 20

ek - X | v

=- & BOOTP (22)
Bl-¢% Operator (3)
== SIL-ATT

-+ Control Unit (3)
+@ Extension (23]
+-§  User (29)

-5 Group (5)

8% Short Code (79)

i Service (0)

ol RAS (1)

+® Incoming Call Row
-4 WAN Port (0)
a4 Directory (0)
L3 Time Profile (0)
(@) Firewall Profile (1)
=l IP Route (4)
- Account Code (0)
- License (34

SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

Line Number 20 In Service

ITSP Domain Name |1D.64.91.40 | Check 003

Local Domain Name | |

URI Type sip v Session Timers

Location Cloud ~ Refresh Method

Timer (sec)

Prefix |

International Prefix |DD

|
Mational Prefix |D |
|
| Redirect and Transfer

Country Code |

Incoming Supervised REFER

Name Priority Systemn Default i

Outgeing Supervised REFER

Description [seC to ATET IPFR |

Send 302 Moved Temporarily
Outgeing Blind REFER

Re-invite

1800

Always

Always

O
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5.5.4. SIP Line — Transport tab

Select the SIP Line = Transport tab and configure the following:

ITSP Proxy Address: Set to the Avaya SBCE Al IP address (e.g., 10.64.91.40).
e Network Configuration - Layer 4 Protocol: Setto TLS.

e Network Configuration - Send Port: Set to 5061.

e Network Configuration - Use Network Topology Info: Set to None.

e Network Configuration - Listen Port: Set to 5061.

e Verify Calls Route via Registrar: Enabled (default)

e Click OK (not shown).

SIP Line Transpert S|P URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering

ITSP Proxy Address |10.6491.40

Metwork Configuration

Layer 4 Protocol TLS v Send Port 3061 2
Use Network Topelogy Info | Nene v Listen Port 3061 =
Explicit DNS Server(s) 0 0 0 0 0 0 0 0

Calls Route via Registrar

Separate Registrar |
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5.5.5.

SIP Line — SIP URI tab

Select the SIP Line - SIP URI tab. To add a new SIP URI, click the Add... button. At the
bottom of the screen, a New URL area will be opened. Configure the following:

e Local URI, Contact and Display Name fields: Set these fields to Use Internal Data.

e Identity: Set to the default None.

e Send Caller ID: Set to Diversion Header. This is required by the AT&T IPFR-EF
service for call redirection scenarios (e.g., Call Forward, Mobile Twinning).

e Verify Diversion Header: Set to the default None.

e Verify Registration: Set to the default 0: <None>.

e Incoming Group: Set to 20 (SIP Line 20). This value references the table created with
Incoming Call Routes in Section 5.8.

e Outgoing Group: Set to 20 (SIP Line 20). This will be used for routing outbound calls to
AT&T via the ARS configuration (Section 5.9).

e Max Sessions: In the reference configuration this was set to 10. This sets the maximum
number of simultaneous calls that can use the URI before Avaya IP Office returns busy to
any further calls.

e Click OK.

IP Offices E SIP Line - Line 20 ek - x| v <]

& “ BOOTP (22) SIP Line Transport SIP URl VolP  T38 Fax SIP Credentials SIP Advanced Engineering
4% Operator (3)
SIL-ATT URl Groups Local URI  Contact Display Name Identity Header Originator Number Send Caller D Diversion Header Credential Max Calls Add...
T et 20 20 <intemal> <intemal> <Infenal>  MNone  PAI
T‘_". L;ne(S] 2 20 220 Aute Auto Auto Mone Pal None Nene 0: <Non... 10 Remove

k] Edit...

=116

=TT

=118

by 17

by 18

g Edit URI

ey 22 oK

=+ Control Unit (3) Local URI [use Internal Data |

A& Extension (23) Cancel
@ User(25) Contact ‘UselntamalData V|
3@ Group (5)
s SHM(?T 9 Display Name [use Internal Data <
- Service (0 Identity
® \Rrﬁil(;?ng Call Route (41 Identity [None -]
48 vian port ) Header P Asserted ID ~
-4 Directory (0)
~{7 Time Profile (0)
@ Firewall Profile (1) Forwarding And Twinnin g
A P Route i4) Originator
8 Account Code (0) Number
% License (34)
& Tunnel (0) Send Caller D Diversion Header ~
4 UserRights (8)
¥ ARS (8)
5 Location (2)
Autherization Code (0)
D Header [N v
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In the sample configuration, the single SIP URI shown above was sufficient to allow incoming
calls for AT&T DID numbers destined for specific IP Office users or IP Office hunt groups. The
calls are accepted by IP Office since the incoming number will match the SIP Name configured
for the user or group that is the destination for the call. URI 2 will match on any number not
associated with users or groups, such as a DID number routed directly to voicemail or DID used
for Mobile Call Control. DID numbers that IP Office should admit can be entered specifically,
such as 3035559320, into the Local URI and Contact fields instead of “Use Internal Data”. To
allow IP Office to admit any number, Auto can be entered into the Local URI and Contact
fields as shown below. This URI entry will not be used for outbound dialing, therefore an unused
number is specified for the Outgoing Group.

SIP Line Transport SIP URl VolP  T38 Fax SIP Credentials SIP Advance: d Engineering

URI  Groups Lecal URI Contact Display Mame Identity Header Originator Number Send CallerID Diversion Header Credential Max Calls Add...

1 20 20 <Internal> <Internal> <Intemal> MNone  PAI Diversion MNone 0: <Non... 10

Edit URI

Local URI ‘Autn ) ‘

Contact ‘Auto V‘

Display Name ‘Autn V‘

Identity

Identity |NDHE V|

Header P Asserted ID >

Forwarding And Twinnin, g

Originator
MNumber

Send Caller ID None ”

5.5.6. SIP Line — VoIP tab
Select the SIP Line = VolP tab.

e The Codec Selection drop-down box = System Default will list all available codecs. In
the reference configuration, Custom was selected with G729(a) 8K CS-ACELP and
G.711 ULAW 64K specified. This causes Avaya IP Office to include these codecs in the
Session Description Protocol (SDP) offer, and in the order specified. Note that in the
reference configuration G.729A is set as the preferred codec on the SIP trunk to the
AT&T IPFR-EF network.

e T.38 fax was used in the reference configuration. Set the Fax Transport Support drop-
down menu to T.38-Fallback. Note that Error Correction Mode (ECM) is enabled by
default on the T.38 Fax tab (Section 5.5.7). ECM is supported by the AT&T IPFR-EF
service. G.711 fax also worked in the reference configuration (T.38 option disabled);
however, T.38-Fallback is the preferred method. See Section 2.2 for limitation with SG3
fax machines.
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e The DTMF Support parameter can remain set to the default value RFC2833/RFC4733.

e Set the Media Security drop-down menu to Same as System (Preferred) to have IP
Office use the system setting for media security set in Section 5.3.5 to encrypted RTP
toward Avaya SBCE.

e The Re-invite Supported parameter can be checked to allow for codec re-negotiation in
cases where the target of an incoming call or transfer does not support the codec
originally negotiated on the trunk.

e Click OK (not shown).

SIP Line Transport SIP URI VoIP 738 Fax SIP Credentials SIP Advanced Engineering
[ VolIP Silence Suppression

[] Lecal Hold Music

Codec Selection Custom N7 Re-invite Supported
4] d Selected
nuse Electe [ Codec Lockdown
G711 ALAW 64K ey 5.729(a) 8K C5-ACELP
G.722 64K G.711 ULAW B4K [ Allow Direct Media Path

G.723.1 6K3 MP-MLQ Force direct media with phones

] PRACK/100rel Supported
[ 6711 Fax ECAN

Fax Transport Support | T38 Fallback ~
DTMF Support RFC2833 ~
Media Security Same as System (Preferred) ~
Advanced Media Security Options Same As System
RTP
RTCP
RTP
RTCP
B4
SRTP_AES_CM_128.

[ SRTP_AES_CM_128_5
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5.5.7. SIP Line = T38 Fax Tab

Note — The settings on this tab are only accessible if Re-invite Supported and a Fax
Transport Support option (T38) are selected on the VVoIP tab (Section 5.5.6).

Select the T38 Fax tab. The Use Default Values is unchecked and the T38 Fax Version is set to
0. All other values are left at default.

SIP Line Transport SIP URI VolP  T38 Fax S|P Credentials SIP Advanced Engineering

T348 Fax Version 0 ~
Scan Line Fix-up
Transport UDPTL
TFQOP Enhancement
Redundancy
[] Disable T30 ECM
Low Speed 0 o . ,
[] Disable EFlags For First DIS
High Speed 0 2 [] Disable T30 MR Compression
TCF Method Trans TCF ~ [ MSF Override
Masx Bit Rate (bps) 14400 v L

ERRIE NS

EFlag Start Timer (ms) 2600

Ak 4

EFlag Stop Timer (ms) 2300

3

T Metwork Timeout (sec) 130

4

[ Use Default Values
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5.5.8. SIP Line — SIP Advanced Tab

By default, Avaya IP Office will use the PPI (P-Preferred-Identity) header for signaling user
information when privacy is invoked. However, AT&T utilizes the PAI (P-Asserted-ldentity)
header for privacy. Therefore, Avaya IP Office is configured to use the PAI header to pass the
calling party information for authentication and billing when privacy is used (see Sections 5.5.5
and 5.7). IP Office can be configured to signal when a call is placed on hold by sending an
INVITE with media attribute “sendonly”. AT&T in turn will respond with media attribute
“recvonly”, and will stop sending RTP media for the duration the call is on hold. When the call is
taken off of hold, IP Office will send another INVITE with media attribute “sendrecv” indicating
to AT&T to start sending RTP again.

e Select Indicate HOLD.

e Select Emulate NOTIFY for Refer.

Note — The AT&T IPFR-EF service does not support NOTIFY. Some Avaya endpoints (e.g.,
Avaya Communicator for Windows) require receipt of a NOTIFY when Refer based call
transfers are performed. This option will send a NOTIFY to these endpoints.

e Select No Refer if using Diversion.

Note — By default, Avaya IP Office sends Refer in addition to Diversion header, for call forward
scenarios. However, AT&T only requires Diversion header. Therefore, in the reference
configuration the No Refer if using Diversion was selected.

e Select the Use PAI for Privacy option, and click Ok (not shown).

SIP Line Transport SIP URI VolP  T38 Fax SIP Credentials SIP Advanced Engineering
Addressing Media
Association Method By Source IP address ~ Allow Empty INVITE O
Send Empty re-INVITE O
Call Routing Method Ri st URI
@l Routing ° L e Allow To Tag Change O
Suppress DNS SRV Lookups | P-Early-Media Support None ~
Send SilenceSupp=Off O
Identity
Use "phone-context” O Media Connection -
. Disabled ~
Add user=phone O Preservation
Use + for International O Indicate HOLD
Use PAl for Privacy
Use Domain for PAI O Call Control
S F d PAI/D =
Wwap From an fHversion O Call Initiation Timeout (s) 4 =
Caller ID from From header ]
Send From In Clear O Call Queuing Timeout (mins) |3 =
Cache Auth Credentials Service Busy Response 486 - Busy Here w
User-Agent and Server Headers I:I on Mo User Responding Send ‘403-Request Timeout ~
Send Location Info fivey e Action on CAC Location Limit | Allow Voicemail ~
Add UUI header O
S 830 R
Ac:;j UUI header te redirected Hu;alpdr:rss Q casen O
calls
Emulate NOTIFY for REFER
Mo REFER if using Diversion
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5.6. Users, Extensions, and Hunt Groups

In this section, examples of an IP Office User, Extension, and Hunt Group will be illustrated. In
the interests of brevity, not all users and extensions shown in Figure 1 will be presented, since
the configuration can be easily extrapolated to other users. To add a User, right click on User in
the Navigation pane, and select New. To edit an existing User, select User in the Navigation
pane, and select the appropriate user to be configured in the Group pane.

5.6.1. H.323 User 322

The following screen shows the User tab for user 322. As shown in Figure 1, this user
corresponds to the Avaya 9608 H.323 endpoint.

User Voicemail DMND Short Codes  Source Numbers  Telephony Forwarding Dialln Voice Recording  Button Programming  Menu Programming  Mobility  Greup Mem

MName |A\ra)r39611 |

Password |ooo|ooooooo |

Confirm Password |uuuuou |

Unigque Identity

Conference PIN |uu |

Confirm Audic Conference PIN |"" |

Account Status Enabled ~
Full Mame | |
Extension |322 |
Email Address | |
Locale ~
Priority 5 ~
System Phone Rights Level 2 ~

Profile Basic User ~

[] Receptionist

The following screen shows the SIP tab for user 6322. The SIP Name and Contact parameters
are configured with the DID number of the user, 3035559322. These parameters configure the
user part of the SIP URI in the From header for outgoing SIP trunk calls, and allow matching of
the SIP URI for incoming calls, without having to enter this number as an explicit SIP URI for
the SIP Line. The SIP Display Name (Alias) parameter can optionally be configured with a
descriptive name. If all calls involving this user and a SIP Line should be considered private,
then the Anonymous parameter may be checked to withhold the user’s information from the
network. See Section 5.7 for a method of using a short code (rather than static user provisioning)
to place an anonymous call.

Forwarding DialIn  Voice Recording Button Programming Menu Programming  Mobility Group Membership  Announcements SIP Personal Directory

5IP Narmne |3035559322 |

SIP Display Mame (Alias) |A\ra)r39611 |

Contact | 3035550322 |

[ Anonymous
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The following screen shows the Mobility tab for user 6322. The Mobility Features and Mobile
Twinning boxes are checked. The Twinned Mobile Number field is configured with the
number to dial to reach the twinned mobile telephone, including the dial access code for ARS, in
this case 93035552177. Other options can be set according to customer requirements.

Forwarding Dialln  Voice Recording Button Programming Menu Programming Mobility  Group Membership  Announcements  SIP Personal Directory
[] Internal Twinning

<MNone=

1
Twin Bridge Appearances
Twin Coverage Appearances
Twin Line Appearances
Mobility Features

Meohbile Twinning

Twinned Mobile Mumber
(including dial access code)

| 93035352177 |

Twinning Time Profile <Mone> w

Mobile Dial Delay (sec) |2 |

Maobile Answer Guard (sec) |0 =
[] Hunt group calls eligible for mobile twinning
[[] Forwarded calls eligible for mobile twinning
[ Twin When Logged Out

[ one-X Mobile Client

Mahile Call Control

Mobile Callback

The following screen shows the Extension information for this user. To view, select Extension
from the Navigation pane, and the appropriate extension from the Group pane.

IPofices  |[i= H.323 Extension: 8006 322 gf - X | v
=- K BOOTP (22) ~ | Extension volP
-7 Operator (3)
E Extension ID |EDDB ‘
+]-F Base Extension |322 ‘
+ <= Control Unit (3)
-4 Extension (23) Phone Password [seee |
z g igi Confirm Phone Password |OOOO ‘
z : :g‘; Caller Display Type On
& 6206 Reset Volume After Calls O
-y T 207
oy 8208 : Avaya 9608
-y 26210 Device Type % 2ye
-4 27211
ol 28212 Location Automatic ~
-y 29213
el 30214 Fallback As Remote Worker Auto i
& 32216
ey 1231 Module D
-, 8004 236
& 31320 Port ]
ol 25 321
‘ Disable Speakerphone O
. 8003 323
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5.6.2. Hunt Groups

During the verification of these Application Notes, users could also receive incoming calls as
members of a hunt group. To configure a new hunt group, right-click Group from the
Navigation pane, and select New. To view or edit an existing hunt group, select Group from the
Navigation pane, and the appropriate hunt group from the Group pane.

The following screen shows the Group tab for hunt group 401. The telephone extensions in the
User List are rung based on the extension that has been unused for the longest period, due to the
Ring Mode setting Longest Waiting (i.e., most idle user receives the next call). Click the Edit
button to change the User List.

IP Offices | = Longest Waiting Group Inbound: 401 [ S I 2

Group  Queuing Overflow Fallback Voicemail Voice Recording Announcements SIP
« Operator (3)

% SIL-ATT Name ‘lnbuuﬂd | Profile Standard Hunt Group v
' Extension [401 | O &xcludeFrom Directory
+ =+ Centrol Unit (3) . = System Default (15 -
-4 Edension (23) Ring Mode Longest Waiting ~ No Answer Time (sec) ystem Default (15) =
4 % gser (2?;] Hold Music Source Mo Change ~
= roup
gq 403 DayAA Ring Tone Override MNone ~
i3 401 Inbound )
20 400 1P Sets ﬁge:te:%atus on Mo-Answer Mone -
54l 200 Main -
4§ 402 vzipCC ser sl
+g zhﬂ’_t C?;)e (79 Extension Name
ervice
o, RAS (1) 322 Avaya®6ll
- Incoming Call Rour 324 Softphone
&) WAN Port (0) 325 Avayall40E
- Directory (0) 329 Mobile
~£1 Time Prefile (0) 01 Avayad508
<18 Firewall Profile (1)
+-Jll IP Route (4)
-8 Account Code (0)
-~ License (34)
-4l Tunnel (0)
f-'a‘, User Rights (8)
" ARS (6)

+I§ Location (2)
-4 Authorization Codi

Edit... Remove

The following screen shows the SIP tab for hunt group 401. The SIP Name and Contact are
configured with AT&T DID 3035554882. Later, in Section 5.8, an Incoming Call Route will
map 3035554882 to this hunt group based on the information entered on this tab.

Group Queuing Overflow Fallback Voicemail Voice Recording Announcements SIP

SIP Name |3035554382 |

SIP Display Name (Alias) [Inbound |

Contact |3035554332 |

[ Anonymeus
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5.7. Short Codes

In this section, various examples of IP Office short codes will be illustrated. To add a short code,
right click on Short Code in the Navigation pane, and select New. To edit an existing short code,
click Short Code in the Navigation pane, and the short code to be configured in the Group pane.

In the screen shown below, the Short Code 9N is illustrated. This Short Code will allow an
Avaya IP Office user to dial the digit 9 followed by any telephone number, symbolized by the
letter N, to reach the SIP Line to the Avaya SBCE/AT&T. However, Avaya IP Office will first
consult the ARS table defined in Section 5.10. The variable N can be any number string.

e The Code parameter is set to 9N

e The Feature parameter is set to Dial

e The Telephone Number parameter is setto N

e The Line Group ID parameter is set to 52: SBC to ATT, which directs the call to

ARS (see Section 0).
e Click the OK button (not shown)

i

IPOffices  ||= 9N: Dial =R
w-R BOOTP (22) ~ | Short Code
+-4% Operator (3)
= SIL-ATT Code [on |
414559 System (1)
#-T7 Line (8) Feature Dial ~
#-< Contrel Unit (3)
-4 Extension (23) Telephone Number |N |
:fm :::LS% Line Group ID [52: 58 to ATT <]
=8% Short Code (79) Locale "
PooBee#33In
% 00 Force Account Code O
:: :313 Force Authorization Code [ ]

Optionally, add or edit a short code that can be used to access the SIP Line anonymously. In the
screen shown below, the short code *67N is illustrated. This short code is similar to the “9N”
short code except that the Telephone Number field begins with the letter “W”, which means
“withhold the outgoing calling line identification”. In the case of the SIP Line connecting to
AT&T documented in these Application Notes, when a user dials ¥*67 plus any number “N”, IP
Office will include the user’s telephone number in the P-Asserted-ldentity (PAI) header (see
Section 5.5.8) along with “Privacy: 1d”. AT&T will allow the call due to the presence of a valid
DID in the PAI header, but will prevent presentation of the caller id to the called PSTN
destination.

IPOffices  ||= *67N: Dial =EEIEIN

=% BOOTP (22) A | Short Code
+-4% Operator (3)

. Code [-e7n |

+-f Feature Dial ~

#-= Control Unit (3)

44 Extension (23) Telephone Number |WN |

+-§  User (23) - )

chon || weoewn [Econ ]

=-8% Short Code (79) Locale ~

LB 3R

x 00 Force Account Code O

S L )| -

ey Force Authorization Code [ ]
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5.8. Incoming Call Routes

Each Incoming Call Route will map a specific AT&T DNIS number to a destination User, Hunt
Group, or Short Code, on Avaya IP Office. To add an incoming call route, right click on
Incoming Call Route in the Navigation pane, and select New (not shown). To edit an existing
incoming call route, select Incoming Call Route in the Navigation pane, and the appropriate
incoming call route to be configured in the Group pane.

Note — In the reference configuration, the AT&T IPFR-EF service delivered ten DNIS digits in
the SIP Invite R-URI. Therefore, incoming calls to Avaya IP Office will match on the ten digit
inbound AT&T DNIS string (e.g., 3035559322). The AT&T IPFR-EF service can also be
configured to deliver seven DNIS digits. Verify the digits being delivered by AT&T.

In the screen shown below, the incoming call route for Incoming Number - 3035559322 is
illustrated. The Line Group ID is set to 20, matching the Incoming Group field configured in
the SIP URI tab for the SIP Trunk to AT&T in Section 5.5.5.

IP Offices || = 20 3035660322 gf -l % v

*"S BOOTP (22) ~ | Standard Voice Recording Destinations
#-ire Operator (3)
= SIL-ATT
59 System (1) &
+ 4 Line (@) Bearer Capability Any Voice
-+ Control Unit (3) | Line Group ID [0 v
+-4f Extension (23)
4 User (25) Incoming Number [3035559322 |
-5 Group (5) | |
|

+1-9% Short Code (79) Inceming Sub Address

4B Service (0)

-y RAS (1)

-@ Incoming Call F

L@

. @20 Priority 1-Low ~
P17

@ 2200000888 | Tag \ |

@ 2200000888

Incoming CLI ‘

Locale ~

Hold Music Source System Source ~

© @ 22 00000288 Ring Tone Override [None 7]
P

Select the Destinations tab. From the Destination drop-down menu, select the extension to
receive the call when AT&T delivers DNIS digits 3035559322. In the reference configuration
DNIS digits 3035559322 is associated with user 322 (the 9608 H.323 telephone).

= 20 3035559322 ef - X v

Standard Voice Recording [Destinations

TimeProfile Destination Fallback Extension

4 Default Value 322 Avaya9611 ~

Repeat this process to route all AT&T DNIS numbers to additional telephone, as well as other
Avaya IP Office destinations (Hunt Group (3035554882), Voicemail (3035559328), etc.).
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5.9. ARS

While detailed coverage of ARS is beyond the scope of these Application Notes, this section
includes basic ARS screen illustrations and considerations. As described in Section 5.7, Short
Code 9N was defined for ARS access. Therefore, outbound calls via ARS are dialed as 9 plus the
number. ARS will strip off the 9 and process the call based on the remaining digits.

e To add a new ARS route, right-click ARS in the Navigation pane, and select New (not
shown). To view or edit an existing ARS route, select ARS in the Navigation pane, and
select the appropriate route name in the Group pane (e.g., 52: SBC to ATT).

e Toadd a new ARS table entry, click on the Add button. To change an existing entry,
click on the Edit button (note that the Edit button is grayed out until an entry is selected).

The following screen shows an example ARS configuration for the route SBC to ATT (ARS
Route ID 52).

e Code = IXXXXXXXXXX This means any dialed string starting with a 1, and 11 digits
total will be routed to the specified Line Group.

e Telephone Number =.

e Feature = Dial

e Line Group ID =20 (SIP Line 20)

IP Offices | = SBC to ATT eh - K| v <>
=K BOOTP (22) ARS
-4 Operator (3)
SIL-ATT ARS Route ID 52 Secondary Dial tone ~
: Line (8) SystemTone v
+ -2 Control Unit (3) Route Name SBC to ATT e
- Extension (23)
+: User (25) Dial Delay Time System Default (4) = Check User Call Barring
-5 Group (5)

-8 Short Code (79)
B Service () Description |A'ITIPFR ‘

+,,% RAS [1)
=@ Incoming Call Rou
&8 WAN Port (0) In Service Out of Service Route <None> v
o Directory (0) 1
1) Time Profile (0)
- Firewall Profile (1) Time Profile <None> ey Outt of Hours Route <None> >
-l 1P Route (4)
- Account Code (0) l
-8, License (34)
& Tunnel (0) Code
#-§3 User Rights (8)
- ARS (6) 1 911 Dial Emergency 20
L 50: Main a1 . Dial 20 Remove
‘¢ 51 temp ON; . Dial 20 -
5 52: SBCto ATT DOOUOCOCON Dial ) e
‘¢ 53 ATTIPTF -
" - TOCRRRIRK ; Dial 20
L B ATT 2
L 61t ATTbackup 911 911 Dial Emergency 20
#-B8 Location (2) 311 311 Dial 20 v
i Authorization Codh

Telephone Number Feature Line Group D ® Add...

% | =  Altemate Route <None> -
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5.10. Save Configuration
Navigate to File > Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.

The following will appear, with either Merge or Immediate selected for the Change Mode,
based on the nature of the configuration changes made since the last save. Note that clicking OK

may cause a service disruption. Click OK if desired.

DDT; Reviewed:
SPOC 4/16/2018

Save Configuration

IP Office Settings
SIL-ATT

Cenfiguration Reboot Mode
® Merge

) Immediate

() When Free

) Tirmed

Reboot Time

Call Barring

oK

Cancel

Help
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6. Configure Avaya Session Border Controller for Enterprise

In the sample configuration, dual Avaya SBCEs are used as edge devices between the CPE and
AT&T.

This section covers the configuration of the Avaya SBCE. It is assumed that the initial
provisioning of the Avaya SBCE, including the assignment of the management interface IP
Address and license installation have already been completed; hence these tasks are not covered
in these Application Notes. For more information on the installation and provisioning of the
Avaya SBCE consult the Avaya SBCE documentation in the Additional References section.

Use a WEB browser to access the Element Management Server (EMS) web interface, and enter
https://ipaddress/sbc in the address field of the web browser, where ipaddress is the management
LAN IP address of the Avaya SBCE.

Enter the Username and click on Continue.

AVAYA =

Continue

WELCOME TO AVAYA SBC

Unautherized access to this machine is prohibited. This system is for

Se33|on Border ContrOI Ier the use authorized users only. Usage of this system may be monitored
.I.'or Entel’pl’ise and recorded by system personnel.

Anyone using this system expressly consents to such menitoring and is
advised that if such menitering reveals possible evidence of criminal
activity, system personnel may provide the evidence from such
menitering to law enfercement officials.

@ 2011 - 2017 Avaya Inc. Al rights reserved.

Enter the password and click on Log In.

Q v Q ﬁ Log In
Username: ucsec

Password:  |eessssseees
Log In
Session Border Controller WELCOME TO AVAYA SBC
for Enterprise Unauthorized access to this machine is prohibited. This system is for

the use authorized users only. Usage of this system may be monitored
and recorded by system personnel.

Anyone using this system expressly consents to such menitering and is
advised that if such moenitoring reveals pessible evidence of criminal
activity, system personnel may provide the evidence from such
monitoring to law enforcement officials.

@ 2011 - 2017 Avaya Inc. All rights reserved.
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The main page of the Avaya SBCE will appear. Note that the installed software version is
displayed. Verify that the License State is OK. The SBCE will only operate for a short time
without a valid license. Contact your Avaya representative to obtain a license.

Alarms  Incidents  Statusv  Logs~  Diagnostics Users Settings v Help ¥ Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard
Backup/Restore

System Time 01:09:17 PM MST Refresh EMS
System Management
. Global Parameters Version 7.2.1.0-05-14222 SBCE
. Global Profiles Build Date Tue Oct 31 00:06:46 UTC 2017
> PPM Services License State @ 0K
» Domain Policies Agaregate Licensing Overages 0
> TLS Management

) Peak Licensing Overage Count 0

> Device Specific Settings

Last Logged in at 02/16/2018 12:28:45 MST

Failed Login Attempts 0

Active Alarms (past 24 hours) Incidents (past 24 hours)

None found SBCE : Max forwards Exceeded

SBCE : Max forwards Exceeded
SBCE : Max forwards Exceeded
SBCE : Max forwards Exceeded

SBCE : Heartbeat Successful, Serveris UP

Add

Na notes found.

6.1. System Management — Status

Select System Management and verify that the Status column says Commissioned. If not,
contact your Avaya representative. To view system information that was configured during
installation, navigate to System Management. A list of installed devices is shown in the right
pane. In the case of the sample configuration, a single device named SBCE is shown. To view
the configuration of this device, click View as highlighted below.

Note — Certain Avaya SBCE configuration changes require that the underlying
application be restarted. To do so, click on Restart Application shown below.

Session Border Controller for Enterprise AVAYA

Dashboard System Management
Administration

Backup/Restore

System Management Devices H Updates H SSL VPN H Licensing H Key Bundles ‘

» Global Parameters Device Name Management IP Version  Status

> Global Profiles 7210
> PPM Services SBCE 10.64.80.40 05- Reboot Shutdown |Restart Application
14222

> Domain Policies

E:t Uninstall

> TLS Management

> Device Specific Settings
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The System Information screen shows the Network Configuration, DNS Configuration and
Management IP(s) information provided during installation and corresponds to Figure 1. In the
shared test environment, the highlighted Al and B2 IP addresses are the ones relevant to the
configuration of the SIP trunk to AT&T.

General Configuration —————————— ~ Device Configuration ————— - License Allocation —M
Appliance Name SBCE HA Mode No Eéecl:\edsaar::l 5Sjession9 50
Box Type SIP Two Bypass Mode No Advancedsgessions .

Deployment Mode  Proxy

Scopia Video Sessions g
Regquesied: 5

AR Sessons 50
Encryption
r Network Configuration
P Public IP Network Prefix or Subnet Mask ~ Gateway Interface
10.64.91.40 10.64.91.40 255.255.255.0 10.64.91.1 Al
10.64.91.41 10.64.91.41 255.255.255.0 10.64.91.1 Al
| 192.168.200.26 192.168.200.26 255255255 248 192.168.200.25 B2 |

r DNS Configuraton ——————  Management IP(s) —————
Primary DNS 10.64.90.201 [ IP#1 (IPvd) 10.64.90.40

Secondary DNS
DNS Location DMz

DNS Client IP 10.64.91.40

6.2. TLS Management

Note — Testing was done using identity certificates signed by a local certificate authority. The
procedure to create and obtain these certificates is outside the scope of these Application Notes.

In the reference configuration, TLS transport is used for the communication between IP Office
and Avaya SBCE. The following procedures show how to view the certificates and configure the
profiles to support the TLS connection.

6.2.1. Verify TLS Certificates — Avaya Session Border Controller for
Enterprise
Step 1 - Select TLS Management => Certificates from the left-hand menu. Verify the
following:
e The root CA certificate is present in the Installed CA Certificates area.
e The signed identity certificate is present in the Installed Certificates area.
e The private key associated with the identity certificate is present in the Installed Keys
area.
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Session Border Controller for Enterprise AVAYA

Dashboard Certificates

Administration Install | | Generate CSR

Backup/Restore

System Management Certificates

> Global Parameters [ ——

> Global Profiles. shed0crt View Delete

> PPM Services

> Domain Palicies Installed CA Certificates

4 TLS Management GSSCPSMGRCA pem View Delete
Certificates SystemManagerCA pem View Delete
Client Profiles
Server Profiles Installed Certificate Revocation Lists

> Device Specific Settings No certificate revocation lists have been installed

Installed Keys
sbcd0 key Delete

6.2.2. Server Profiles

Step 1 - Select TLS Management - Server Profiles, and click on Add. Enter the following:
e Profile Name: enter descriptive name.
e Certificate: select the identity certificate, e.g., sbc40.crt, from pull down menu.
e Peer Verification = None.

e Click Next.
Step 2 - Accept default values for the next screen (not shown) and click Finish.

Edit Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will

pass even if one or more of the ciphers are invalid as long as at least one cipher is valid. Make
sure to carefully check your entry as invalid or incomectly entered Cipher Suite custom values
may cause catastrophic problems.

Profile Name shcdl-server
Certificate shcdl.crt M
Peer Verification MNona v

GSSCPSMGRCA pem -

A I A
Peer Certificate Authorities SystemManagerCA.pem

Peer Certificate Revocation Lists

Verification Depth 0

Next
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The following screen shows the completed TLS Server Profile form:

Dashboard

Administration

Backup/Restore

System Management

» Global Parameters

» Global Profiles

» PPM Services

» Domain Policies

4 TLS Management
Certificates
Client Profiles
Server Profiles

» Device Specific Settings

Session Border Controller for Enterprise

Server Profiles: sbc40-server

Server Profiles

sbcd0-server

Add

Click here 1o add a description.

Server Profile

AVAYA

Delete

TLS Profile

Profile Name sbed0-server

Certificate sbed crt

Ceriificate Verification

Peer Verification None

Extended Hostname Verification

Renegotiation Parameters
Renegotiation Time 0

Renegotiation Byte Count 0

Handshake Options

Varsion 4 TLS12 TLS 14 LS 1.0
Ciphers Default FIPS Custom
Value HIGH:IDH:IADH:IMD5:laNULL:leNULL-@STRENGTH
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6.2.3. Client Profiles
Step 1 - Select TLS Management - Client Profiles, and click on Add. Enter the following:

Profile Name: enter descriptive name.

Certificate: select the identity certificate, e.g., sbc40.crt, from pull down menu.
Peer Verification = Required.

Peer Certificate Authorities: select the CA certificate used to verify the certificate
received from Session Manager, e.g., SystemManagerCA.pem.

Verification Depth: enter 1.

Click Next.

Step 2 - Accept default values for the next screen (not shown) and click Finish.

Edit Profile X

WARNING: Due to the way OpenSSL handles cipher checking, Cipher Suite validation will
pass even if one or more of the ciphers are invalid as long as at least one cipher is valid. Make

sure to carefully check your entry as invalid or incomectly entered Cipher Suite custom values
may cause catastrophic problems.

TLS Profile

Profile Name shcdl-client

Certificate shcdl.crt v
Certificate Verification

Peer Verification Required

GSSCPSMGRCA . pem

Peer Certificate Authoritias SystemManagerCA.pem
Peer Certificate Revocation Lists
Verification Depth 1
Extended Hostname Verification
Custom Hostname Override
MNext
DDT; Reviewed: Solution & Interoperability Test Lab Application Notes 44 of 73

SPOC 4/16/2018 ©2018 Avaya Inc. All Rights Reserved. IPO101SBC72FR



The following screen shows the completed TLS Client Profile form:

Session Border Controller for Enterprise AVAYA
Dashboard Client Profiles: sbc40-client

Administration Add Delete
Backup/Restore

System Management

> Global Parameters sbed-client Client Profile

> Global Profiles

. PPM Services

» Domain Policies Profile Name shed0-client

< TLS Management Certificate sbed0. crt

Certificates

Client Profiles i Soilin vy
Server Profiles Peer Verification Required

» Device Specific Settings Peer Certificate Authorities SystemManagerCA pem

Peer Certificate Revocation Lists

Verification Depth 1

Extended Hostname Verification

Renegotiation Parameters
Reneagotiation Time 0

Renegotiation Byte Count (]

Handshake Options

Varsion 4 TLS 1.2 TLS 1.1 TLS 1.0
Ciphers Default FIPS Custom
Value HIGH:IDH:IADH:IMD5:laNULL:leNULL. @ STRENGTH
| Edit |

6.3. Network Management

The Network Management screen is where the network interface settings are configured and
enabled. During the installation process of Avaya SBCE, certain network-specific information is
defined such as device IP address(es), public IP address(es), netmask, gateway, etc., to interface
the device to the network. It is this information that populates the various Network Management
tab displays, which can be edited as needed to optimize device performance and network
efficiency. Navigate to Device Specific Settings = Network Management and verify the IP
addresses assigned to the interfaces and that the interfaces are enabled. The following screen
shows the enterprise interface is assigned to Al and the interface towards AT&T is assigned to
B2.
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The following Avaya SBCE IP addresses and associated interfaces were used in the sample
configuration:

e B2:192.168.200.26 — IP address configured for the AT&T IPFR-EF service. This
address is known to AT&T. See Section 3.
e A1:10.64.91.40 — IP address configured for AT&T IPFR-EF service to IP Office.

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: SBCE
Administration
Backup/Restore
System Management Interfaces || Networks
> Global Parameters SBCE Add
» Global Profiles
» PPM Services Name Galeway S:::"EI L Interface IP Address
» Domain Policies Inside-A1 10.64.91.1 255.255.255.0 Al 10.64.91.40, 106491.41  Edit Delete
 TLS Management Outside-B2 192.168.200.25 255.255.255.248 B2 192.168.200.26 Edit Delete
4 Device Specific Settings
Network Edit Delete
Management
Edit Delete
Media Interface
Edit Delete

Signaling Interface
End Point Flows

Session Flows

The following screen shows interface Al, and B2 are Enabled. To enable an interface click the
corresponding Disabled Status link to change it to Enabled.

Session Border Controller for Enterprise AVAYA
Dashboard Network Management: SBCE
Administration
Backup/Restore
Systom Management Intorfaces || Networks
> Global Parameters SBCE Add VLAN
> Global Profiles
A Interface Name VLAN Tag Status

> PPM Services 1 E—
> Domain Policies nebied
> TLS Management A2 Disabled
4 Device Specific Settings B1 Enabled

Network B2 Enabled

Management

Media Interface
Signaling Interface

6.4. Server Interworking Profile

The Server Internetworking profile includes parameters to make the Avaya SBCE function in an
enterprise VolP network using different implementations of the SIP protocol. There are default
profiles available that may be used as is, or modified, or new profiles can be configured as
described below.

In the sample configuration, separate Server Interworking Profiles were created for IP Office and
AT&T IPFR-EF service.
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6.4.1. Server Interworking Profile — IP Office

In the sample configuration, the IP Office Server Interworking profile was cloned from the
default avaya-ru profile. To clone a Server Interworking Profile for IP Office, navigate to
Global Profiles = Server Interworking, select the avayu-ru profile and click the Clone
button. Enter a Clone Name and click Finish to continue.

Clone Profile

Profile Name avaya-u

Clone Name Enterprise Interwork

Finish

The following screen shows the Enterprise Interwork profile used in the sample configuration,
with T.38 Support set to Yes. To modify the profile, scroll down to the bottom of the screen and
click Edit. Select the T.38 Support parameter and then click Next and then Finish (not shown).
Default values can be used for all other fields.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: Enterprise Interwork
Administration Add Rename | Clone || Delete
Backup/Restore
Click hera to add a description.
System Management
€s2100
> Global Parameters General || Timers H Privacy H URI i H Header Manipulati H ‘
< Global Profiles avaya-ru n
i Hold S t NONE
Domain DoS ATT-Intarworking o1 Suppo
Server Interworking N 180 Handling None
A Enterprise Interwork
Media Forking 181 Handling None
Routing 162 Handling None
Server Configuration
- 183 Handli N
Topology Hiding ending one
Signaling Manipulation Refer Handling No
URI Groups URI Group None
SNMP Traps Send Hold No
Time of Day Rules Delayed Offer No
FGDN Groups
3y Handlis N
Reverse Proxy Policy FIAEELC ©
RADIUS Diversion Header Support No
» PPM Services Delayed SDP Handling No
> Domain Policies Re-Invite Handling No
a
TLS Management Prack Handling No
Certificates
Client Profiles Alow 18X SOP to
Server Profiles T.38 Suppont Yes
» Device Specific Settings URI Scheme SIP
Via Header Format RFC3261
_Edit h

DDT; Reviewed:
SPOC 4/16/2018

Solution & Interoperability Test Lab Application Notes

©2018 Avaya Inc. All Rights Reserved.

47 of 73
IPO101SBC72FR




6.4.2. Server Interworking Profile — AT&T

To create a new Server Interworking Profile for AT&T, navigate to Global Profiles = Server
Interworking and click Add as shown below. Enter a Profile Name and click Next.

Interworking Profile

Profile Name

ATT-Interworking

Next

The following screens show the ATT-Interworking profile used in the sample configuration.
On the General tab, default values are used with the exception of T.38 Support set to Yes.

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

» Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups
Reverse Proxy Policy
RADIUS

> PPM Services

» Domain Policies

4 TLS Management
Certificates
Client Profiles
Server Profiles

» Device Specific Settings

Interworking Profiles: ATT-Interworking

cs2100
avaya-ru
ATT-Interworking

Enterprise Interwork

Add

Hold Support

180 Handling
181 Handling
182 Handling
183 Handling
Refer Handling
URI Group
Send Hold
Delayed Offer
3xx Handling
Diversion Header Support
Delayed SDP Handling
Re-Invite Handling
Prack Handling
Allow 18X SDP
T.38 Support
URI Scheme

Via Header Format

General || Timers || Privacy | | URI Manipulatic

NONE
None
None
None
None
No

None

RFC3261

[ Edn |

AVAYA
Rename || Clone || Delete

Interworking Profiles Click here to add a description.
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The Timers tab shows the values used for compliance testing for the Trans Expire field. The
Trans Expire timer sets the allotted time the Avaya SBCE will try the first primary server
before trying the secondary server, if it exists (see Section 11 for multiple AT&T border

elements).

Dashboard
Administration
Backup/Restore
System Management

SAIND Tran

Session Border Controller for Enterprise

Interworking Profiles: ATT-Interworking

Add

AVAYA

Rename || Clone || Delete

Interworking Profiles Click here to add a description.

> Global Parameters es2100 General H Timers H Privacy || URI Manipulati || Header Manipulati H Ad: d |
4 Global Profiles avaya-ru
SIP Timers
Domain DoS Enterprise-Interwork Min-SE .
Server Interworking )
ATTInterworking it Ti

Media Forking IS -

Routing Max Timer

Server Configuration Trans Expire 4 seconds

Topology Hiding Invite Expire

Signaling Manipulation

URI Groups Edit

Click Next to accept default parameters for the Privacy, URI Manipulation, and Header
Manipulation tabs (not shown) and advance to the Advanced area. Record Routes is set to
Both Sides. Default values can be used for all other fields.

Dashboard
Administration
Backup/Restore
System Management

Signaling Manipulation

> Domain Policie

Session Border Controller for Enterprise

Interworking Profiles: ATT-Interworking

Add

AVAYA

Rename || Clone || Delete

Interworking Profiles Click here to add a description.

c2100

» Global Parameters General ‘ ‘ Timers. ‘ ‘ Privacy | ‘ URI Manipulati ‘ | Header Manipulati ‘ | Ad | |
4 Global Profiles avaya-ru
Record Routes Both Sides
Domain DoS Enterprise-Intenvork
Server Interworking . Include End Point IP for Context Lookup No
ATTInterworking
Media Forking Extensions None
Routing Diversion Manipulation No
Server Configuration Has Remote SBC Yes
Topology Hiding
Route Response on Via Port No

URI Groups Relay INVITE Replace for SIPREC No
SNMP Traps
DTMF
Time of Day Rules s .
Tt
FGDN Groups Uppo! one
» PPM Services Edit

6.5. Signaling Manipulation

Signaling Manipulations are SigMa scripts the Avaya SBCE can use to manipulate SIP
headers/messages. In the reference configuration, one signaling manipulation script is used.

Note — Use of the Signaling Manipulation scripts require higher processing requirements on the
Avaya SBCE. Therefore, this method of header manipulation should only be used in cases where
the use of Server Interworking Profiles (Section 7.4) or Signaling Rules (Section 7.11) does not
meet the desired result. Refer to [7] for information on the Avaya SBCE scripting language.
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Step 1 - As described in Section 2.2, Item 2, when an inbound call with AT&T IPFR-EF
Sequential Ringing feature activated is answered by voicemail, no audio is heard. To fix this
issue, the initial INVITE is manipulated to change the SDP media attribute “sendonly” to
“sendrecv”.

1. Select Global Profiles from the menu on the left-hand side.

2. Select Signaling Manipulation.

3. Click Add Script (not shown) and the script editor window will open.

4. Enter a name for the script in the Title box (e.g., IPFR-EF with IPO). The following

script is defined:

Title [IPFR-EF with IPO Save

S ATET sequential Rimging, chamge a=sendonly to a=sendrecv
within session "ALL"

act on request where XDIRECTION="OUTEOUND" and ZENTRY_POINT="POST_ROUTIMNG"

ZBODY[1].regex_replace("a=sendonly”, "a=sendrecy” );

Step 2 - Click on Save. The script editor will test for any errors, and the window will close. This
script is applied to the AT&T Server Configuration profile in Section 6.6.2.

6.6. Server Configuration

The Server Configuration contains parameters to configure and manage various SIP call server-
specific parameters such as TCP and UDP port assignments, heartbeat signaling parameters, DoS
security statistics, and trusted domains.

In the sample configuration, separate Server Configurations were created for IP Office and
AT&T IPFR-EF service.

6.6.1. Server Configuration — IP Office

To add a Server Configuration Profile for IP Office, navigate to Global Profiles = Server
Configuration and click Add. Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile

Profile Name IPO-500v2 CallServer

Next
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The following screens illustrate the Server Configuration for the Profile name 1PO-500v2
CallServer. In the General parameters, the Server Type is set to Call Server. In the IP
Address / FQDN field, the IP Address of IP Office LAN 1 interface in the sample configuration
is entered. This IP address is 10.64.19.70. Under Port, 5061 is entered, and the Transport
parameter is set to TLS. The TLS profile sbc40-client created in Section 7.2.3 is selected for
TLS Client Profile. If adding the profile, click Next (not shown) to proceed. If editing an
existing profile, click Finish.

Edit Server Configuration Profile - General X

Server Type can not be changed while this Server Configuration profile is associated to a Server

I

Server Type Call Server

SIP Domain

TLS Client Profile shcdl-client *

[
IP Address / FQDN Port Transport
10.64.19.70 5061 TLS v | Delete
| Finish |

Default values can be used on the Authentication tab, click Next (not shown) to proceed to the
Heartbeat tab. The Avaya SBCE can be configured to source “heartbeats” in the form of PINGs
or SIP OPTIONS towards IP Office. When remote workers are configured, IP Office may not
respond to SIP OPTIONS from the SBCE IP address designated for remote workers; therefore
PING will be used instead.

Select PING from the Method drop-down menu. Select the desired frequency that the SBCE
will source PINGs towards IP Office.

IPO-500v2 CallServer

| Rename || Clone || Delete |

General H Authentication H Heartbeat H Ping H Advanced ‘

Enable Heartbeat r

Method OPTIONS

Frequency 60 seconds
From URI SBCE@silipo.avayalab.com

To URI IP500v2@silipo.avayalab.com

Edit

DDT; Reviewed:
SPOC 4/16/2018

Solution & Interoperability Test Lab Application Notes
©2018 Avaya Inc. All Rights Reserved.

51 0of 73
IPO101SBC72FR



On the Advanced tab, Enable Grooming is check and the Interworking Profile is set to
Enterprise Interwork created in Section 6.4.1 for IP Office.

IPO-500v2 CallServer

| Rename || Clone || Delete |

General H Authentication ‘ ‘ Heartbeat H Ping | ‘ Advanced ‘
Enable Do$S Protection
Enable Grooming i
Interworking Profile Enterprise Interwork
Signaling Manipulation Script None
Securable
Enable FGDN
Tolerant
URI Group None
| Edit

6.6.2. Server Configuration — AT&T

To add a Server Configuration Profile for AT&T, navigate to Global Profiles = Server
Configuration and click Add. Enter a descriptive name for the new profile and click Next.

Add Server Configuration Profile

Profile Name

The following screens illustrate the Server Configuration for the Profile name ATT-trk-svr. In
the General parameters, the Server Type is set to Trunk Server. In the IP Address / FQDN
field, the AT&T-provided IP address is entered. This is 192.168.38.69. Under Port, 5060 is
entered, and the Transport parameter is set to UDP. If adding the profile, click Next (not
shown) to proceed. If editing an existing profile, click Finish.

Edit Server Configuration Profile - General X
Server Type Trunk Server v
SIP Domain
TLS Client Profile None v
Add
IP Address / FQDN Port Transport
192.168.38.69 5060 UDP v | Delete
Back Next
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Default values can be used on the Authentication tab, click Next (not shown) to proceed to the
Heartbeats tab. The Avaya SBCE can be configured to source “heartbeats” in the form of SIP
OPTIONS towards AT&T. This configuration is optional. Independent of whether the Avaya
SBCE is configured to source SIP OPTIONS towards AT&T, AT&T will receive OPTIONS
from the IP Office site as a result of the Check OOS parameter being enabled on IP Office (see
Section 5.5.3). When IP Office sends SIP OPTIONS to the inside private IP Address of the
Avaya SBCE, the Avaya SBCE will send SIP OPTIONS to AT&T. When AT&T responds, the
Avaya SBCE will pass the response to IP Office.

Select OPTIONS from the Method drop-down menu. Select the desired frequency that the
SBCE will source OPTIONS. The From URI and To URI may be filled in to configure easily
identifiable URISs to appear in SIP OPTIONS sourced by the Avaya SBCE. If adding a new
profile, click Next to continuing to the Advanced settings.

ATT-trk-svr
Rename || Clone || Delete
General H Authentication H Heartbeat H Ping H Advanced ‘
Enable Heartbeat v
Method OPTIONS
Frequency 300 seconds
From URI SBCE@avaya.com
To URI IPFR@att.com
Edit
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On the Advanced tab, Enable Grooming is not used for UDP connections and is left
unchecked. The Interworking Profile is set to AT T-Interworking created in Section 6.4.2 for
AT&T. The Signaling Manipulation Script is set to the script created in Section 6.5.

AT T-trk-svr

| Rename || Clone || Delete |

General H Authentication | ‘ Heartbeat ‘ ‘ Ping ‘ | Advanced ‘

Enable DoS Protection

Enable Grooming

Interworking Profile AT T-Interwarking
Signaling Manipulation Script IPFR-EF with IPO
Securable
Enable FGDN
Tolerant
URI Group None

| it

6.7. Routing Profile

Routing profiles define a specific set of packet routing criteria that are used in conjunction with
other types of domain policies to identify a particular call flow and thereby ascertain which
security features will be applied to those packets. Parameters defined by Routing Profiles include
packet transport settings, name server addresses and resolution methods, next hop routing
information, and packet transport types.

Create a Routing Profile for IP Office and AT&T IPFR-EF service. To add a routing profile,
navigate to Global Profiles = Routing and select Add. Enter a Profile Name and click Next to
continue.

Routing Profile

Profile Name To IPO 500v2

Next
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The following screen shows the Routing Profile To IPO 500v2 created in the sample
configuration. The parameters in the top portion of the profile are left at their default settings.
The Priority / Weight parameter is set to 1, and the IP Office Server Configuration, created in
Section 6.6.1, is selected from the drop-down menu. The Next Hop Address is automatically
selected with one of the values from the IP Office Server Configuration, and Transport becomes
greyed out. Select the TLS entry from the drop-down menu for the Next Hop Address, and
select Finish.

Profile : To IPO 500v2 - Edit Rule

URI Group T Time of Day default v
Load Balancing Prigrity ¥ NAPTR
Transport MNone ¥ Next Hop Priority I
Next Hop In-Dialog Ignore Route Header
ENUM ENUM Suffix
| Add |
Priority / Weight ~ Server Configuration Next Hop Address Transport
1 IPO-500v2 CallServer v 10.64.19.70:5061 (TLS) M None v | Delete
| Finish |

Similarly add a Routing Profile to AT&T. The following screen shows the Routing Profile To
ATT IPFR created in the sample configuration. The parameters in the top portion of the profile
are left at their default settings. The Priority / Weight parameter is set to 1, and the AT&T
Server Configuration, created in Section 6.6.2, is selected from the drop-down menu. The Next
Hop Address is automatically selected with the values from the Server Configuration, and
Transport becomes greyed out. Click Finish.

Profile : To ATT IPFR - Edit Rule

URI Group A Time of Day default
Load Balancing Priority v NAPTR
Transport MNone ¥ Mext Hop Priority '
Mext Hop In-Dialog Ignore Route Header
ENUM ENUM Suffix
| Add |
Priority / Weight  Server Configuration MNext Hop Address Transport
1 ATT-trk-svr v 192.166.38.69:5060 (UDP) v None v | Delete
| Finish |
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6.8. Topology Hiding Profile

The Topology Hiding profile manages how various source, destination and routing information
in SIP and SDP message headers are substituted or changed to maintain the integrity of the
network. It hides the topology of the enterprise network from external networks.

Click the Add button to add a new profile, or select an existing topology hiding profile to edit. In
the sample configuration, the default profile was cloned for AT&T and IP Office and will later

be applied to the Server Flows in Section 6.16.

In the Replace Action column an action of Auto will replace the header field with the IP address
of the Avaya SBCE interface and the Overwrite will use the value in the Overwrite Value.

In the example shown, SIP-Trunk-Topology was cloned from the default.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups

> PPM Services

Topology Hiding Profiles: SIP-Trunk-Topology
| Add

Topology Hiding Profiles Click here to add a description.

default
cisco_th_profile
Enterprise-Topology

SIP-Trunk-Topology

Session Border Controller for Enterprise

Topology Hiding

AVAYA

| Rename || Clone || Delete

Header

To
Record-Route
From
Referred-By
SDP

Via
Request-Line

Refer-To

Criteria

IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action
Auto
Auto
Auto
Auto
Auto
Auto
Auto

Auto

Edit

Overwrite Value
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6.9. Application Rule

Application Rules define which types of SIP-based Unified Communications (UC) applications
the Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In
addition, you can determine the maximum number of concurrent voice and video sessions the
network will process in order to prevent resource exhaustion.

Select Domain Policies = Application Rules from the left-side menu as shown below. Click
the Add button to add a new profile, or select an existing application rule to edit. In the sample
configuration, the sip-trunk rule was created for IP Office and AT&T. In an actual customer
installation, set the Maximum Concurrent Sessions for the Audio and Video applications to a
value slightly larger than the licensed sessions. For example, if licensed for 150 session set the
values to 200. The Maximum Session Per Endpoint should match the Maximum Concurrent
Sessions.

Session Border Controller for Enterprise AVAYA
Dashbeard Application Rules: sip-trunk
Administration Add Filter By Device v Rename || Clone || Delete
Backup/Restore
default
> Global Parameters Application Rule
> Global Profiles default-trunk
. PPM Services P —— Application Type Maximum Sessions Per Endpoint
4 Domain Policies Audio el < 200 200
L default-subscriber-high

Application Rules Video ’ v 200 200

Border Rules default-server-low

eda e cefedzenertish

Security Rules sip-trunk CDR Support off

Signaling Rules

RTCP Keep-Alive No
End Point Policy
Groups Edit

easion Policie:

6.10. Media Rule

Media Rules define RTP media packet parameters such as prioritizing encryption techniques and
packet encryption techniques. Together these media-related parameters define a strict profile that
is associated with other SIP-specific policies to determine how media packets matching these
criteria will be handled by the Avaya SBCE security product.

Select Domain Policies = Media Rules from the left-side menu as shown below. In the sample
configuration, the default media rule avaya-low-med-enc was cloned for IP Office, enterprise
med rule, and modified as shown below. With the avaya-low-med-enc rule chosen, click
Clone. Enter a descriptive name for the new rule and click Finish (not shown).
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In the sample configuration, media rule enterprise med rule was used for IP Office as shown

below.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

4 Domain Policies
Application Rules
Border Rules
Media Rules
Security Rules
Signaling Rules

End Point Policy
Groups

Session Policies
» TLS Management

» Device Specific Settings

| Media Rules: enterprise med rule |

Add

Media Rules

default-low-med
default-low-med-enc
default-high
default-high-enc
avaya-low-med-enc
ipvB-anat-media

att med rule

enterprise med rule

Filter By Device.

Rename Delete

Click here to add a description.

Encryption H Codec Prioritization H Advanced | QoS

Audio Encryption
Preferred Formats
Encrypted RTCP
MKI

Lifetime

Interworking

Video Encryption
Preferred Formats
Encrypted RTCP
MKI

Lifetime

Interworking

Miscellaneous

Capability Negaotiation

SRTP_AES_CM_128_HMAC_SHA1_80
RTP

Any

SRTP_AES_CM_128_HMAC_SHA1_80
RTP

Any

Edit

Similarly, the default media rule default-low-med was cloned for AT&T IPFR-EF, att med
rule. The AT&T Media Rule is shown below with the DSCP values EF for expedited forwarding
(default value) for Media QoS.

Session Border Controller for Enterprise

Dashboard

Administration

Backup/Restore

System Management

» Global Parameters

» Global Profiles

» PPM Services

4 Domain Policies
Application Rules
Border Rules
Meclia Rules
Security Rules
Signaling Rules

End Paint Policy
Groups

Session Policies

<4 TLS Management

‘ Media Rules: att med rule

Add

Media Rules

—— default-low-med

default-low-med-enc
default-high
default-high-enc
avaya-low-med-enc
ipvé-anat-media

att med rule

enterprise med rule

| Filter By Device

AVAYA

Rename Delete

Click here to add a description.

m

— ||Cmlec

ledia QoS Marking

Enabled

QoS Type

Audio QoS
Audio DSCP

Video QoS
Video DSCP

‘

DSCP

EF

EF
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6.11. Signaling Rule

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

Clone and modify the default signaling rule to add the proper quality of service to the SIP
signaling. To clone a signaling rule, navigate to Domain Policies = Signaling Rules. With the
default rule chosen, click Clone. Enter a descriptive name for the new rule and click Finish (not
shown). In the sample configuration, signaling rule enterprise sig rule is unchanged from the

default rule.

Dashboard
Administration
Backup/Restore
Systemn Management

> Global Profiles
» PPM Services
4 Domain Policies

Security Rules
Signaling Rules
End Point Policy

| Signaling Rules: enterprise sig rule |

Add

Signaling Rules Click here to add a description.

» Global Parameters —P  default

MNe-Content-Type-Chec
enterprise sig rule

att sig rule

Filter By Device.

v

Rename Delete

General ‘ | Requests ‘ | Responses ‘ | Request Headers | ‘ Response Headers | ‘ Signaling QoS | ucip

Requests

Requests

Application Rules Non-2XX Final Responses Allow
Border Rules Optional Request Headers Allow
Media Rules .

Optional Response Headers Allow

Groups
Non-2XX Final Responses Allow
Session Policies
> TLS Management Optional Request Headers Allow
» Device Specific Settings Optional Response Headers Allow

Content-Type Policy

Enable Content-Type Checks v
Action Allow Multipart Action Allow
Exception List Exception List

[Edit|

Allow

Allow

Signaling rule att sig rule was also cloned from the default rule and used for AT&T. The DSCP
value AF41 for assured forwarding (default value) was set for Signaling QoS.

Dashboard
Administration
Backup/Restore
System Management

> Global Profiles

Signaling Rules

| Signaling Rules: att sig rule |

Add

Filter By Device...

v

Rename Delete

Signaling Rules Click here to add a description.

» Global Parameters =% default

No-Content-Type-Chec

General ‘ | Requests ‘ | Responses | ‘ Request Headers | ‘ Response Headers ‘ | Signaling QoS ‘ ucip

> PPM Services enterprise sig rule Signaling Qo3 ’

4 Domain Policies att sig rule QoS Type Dscp
Application Rules DSCP AF41
Border Rules
Media Rules LEdt |
Security Rules

DDT; Reviewed:
SPOC 4/16/2018

Solution & Interoperability Test Lab Application Notes
©2018 Avaya Inc. All Rights Reserved.

59 of 73
IPO101SBC72FR




6.12. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to a Server Flow in Section 6.16.

To create a new policy group, navigate to Domain Policies = Endpoint Policy Groups and
click on Add as shown below. The following screen shows the enterprise policy created for IP
Office. The details of the non-default rules chosen are shown in previous sections.

Dashboard

Administration

Backup/Restore

System Management

> Global Parameters

> Global Profiles

> PPM Services

< Domain Policies
Applicaticn Rules
Border Rules
Media Rules
Security Rules
Signaling Rules

End Point Policy
Groups

Session Policies
> TLS Management

> Device Specific Setfing

Policy Groups: enterprise policy
Add Filter By Device. Rename || Clone || Delete
Policy Groups Click here to add a description.
default-low

Policy Group

default-low-enc

default-med

default-med-enc Summary
default-high Order Application Border Media Security Signaling

default-high-enc 1 sip-trunk default default-low-med default-low enterprise sig rule Edit

avaya-def-low-enc
avaya-def-high-subscri...
avaya-def-high-server
att-palicy-group

enterprise policy

The following screen shows the att-policy-group created for AT&T. The details of the non-
default rules chosen are shown in previous sections.

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
> Global Profiles

Policy Groups: att-policy-group
Add Filter By Device Rename || Clone || Delete
Click here to add a description.
default-low

default-low-enc

> PPM Services default-med Policy Group
# Domain Policies default-med-enc \Sumﬂ/
Application Rules Order Application Border Media Security Signaling
default-high
Border Rules
Media Rules default-high-enc 1 sip-trunk default att med rule default-low att sig rule Edit
Security Rules avaya-def-Jow-enc
Signaling Rules avaya-def-high-subscri
End Point Policy
Groups avaya-def-high-server
Session Policies att-policy-group
» TLS Management 5 :
enterprise policy
» Devire Snerific Setting
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6.13. Advanced Options

In Section 6.14, the media UDP port ranges required by AT&T are configured (16384 — 32767).
However, by default part of this range is already allocated by the Avaya SBCE for internal use
(22000 - 31000). The following steps reallocate the port ranges used by the Avaya SBCE so the
range required by AT&T can be defined in Section 6.14.

Step 1 - Select Device Specific Settings = Advanced Options from the menu on the left-hand
side.

Step 2 - Select the Port Ranges tab.

Step 3 - In the Signaling Port Range row, change the range to 12000 — 16380

Step 4 - In the Config Proxy Internal Signaling Port Range row, change the range to 42000 —
51000.

Step 5 — In the Listen Port Range row, change the range to 6000 — 6999.

Step 6 — In the HTTP Port Range row, change the range to 51001 — 62000.

Step 7 - Select Save. Note that changes to these values require an application restart (see Section

6.1).
Session Border Controller for Enterprise AVAYA
Application Rules = Advanced Options: SBCE
Border Rules
Media Rules CDR Listing ‘ ‘ Feature Control | ‘ SIP Options ‘ ‘ Network Options ‘ ‘ Port Ranges | ‘ RTCP Monitoring || Load Monitoring |
Security Rules SBCE
Signaling Rules Changes to the settings below require an application restart before taking effect. Application restarts can be issued from System Management.
Groups
Session Policies Signaling Port Range 12000 -|16380
» TLS Management Config Proxy Internal Signaling Port Range 42000 - 51000
4 Device Specific Settings
Network
Management Listen Port Range 6000 - 6999
Media Interface
Signaling Interface
End Point Flows HTTP Port Range 51001 -|62000
Session Flows [Save |
> DMZ Services S
TURN/STUN
Service
SNMP
Syslog Management
Advanced Options
> Troubleshoating
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6.14. Media Interface

The Media Interface screen is where the SIP media ports are defined. Avaya SBCE will send SIP
media on the defined ports. Create a SIP media interface for the inside and outside IP interfaces.

To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click Add. The following screen shows the media interfaces defined for the sample
configuration.

Session Border Controller for Enterprise AVAYA

Dashboard Media Interface: SBCE
Administration
Backup/Restore

Devie i
System Management Medla ntriace
> Global Parameters SBCE
Modifying or deleting an existing media interface will require an application restart before taking effect. Application restarts can be issued from System
> Global Profiles. Management.
» PPM Services e
> Domain Policies LAk
Media IP
» TLS Management Name et Port Range
4 Device Specific Settings
° 9 Outside-82-Media 19218820096 o 16384 - 32767 Edit Delete
Network Management uiside-82 (B2. VLAN 0)
Media Interface Inside-Media-Interface o 16384 - 32767 Edit Delete

6.15. Signaling Interface

The Signaling Interface screen is where the SIP signaling ports are defined. Avaya SBCE will
listen for SIP requests on the defined ports. Create a signaling interface for the inside and outside
IP interfaces.

To create a new Signaling Interface, navigate to Device Specific Settings = Signaling
Interface and click Add. The following screen shows the signaling interfaces defined for the
sample configuration.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Interface: SBCE
Administration
Backup/Restore

System Management m Signaling Interface
» Global Parameters SBCE
Modifying or deleting an existing signaling interface will require an application restart before taking effect. Application restarts can be issued from System
» Global Profiles Management.
» PPM Services [add
» Domain Policies
> TLS Management Name Sl TCPPot  UDPPot TLSPort  TLS Profile
# Device Specific Setings Outside-B2-Signaling 192168 200.26 5060 None Edit Delete
Network Maﬂagem&:m utside-B2 (B2. VLAN 0)
Media Interface Inside-Sig-40 108490 ey 5061 sbed0-server Edit Delete
Signaling Interface
End Point Flows Edil Delete
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6.16. End Point Flows - Server Flow

When a packet is received by Avaya SBCE, the content of the packet (IP addresses, URISs, etc.)
is used to determine which flow it matches. Once the flow is determined, the flow points to a
policy which contains several rules concerning processing, privileges, authentication, routing,
etc. Once routing is applied and the destination endpoint is determined, the policies for this
destination endpoint are applied. The context is maintained, so as to be applied to future packets
in the same flow.

Create a Server Flow for IP Office and AT&T IPFR-EF service. To create a Server Flow,
navigate to Device Specific Settings = End Point Flows. Select the Server Flows tab and click
Add as highlighted below.

Session Border Controller for Enterprise AVAYA
Dashboard End Point Flows: SBCE
Administration
Backup/Restore
Subscriber Flows | | Server Flows ‘
System Management
> Global Parameters SBCE Add |
> PP Service:

The following screen shows the flow named 500v2 Flow viewed from the sample configuration.
This flow uses the interfaces, polices, and profiles defined in previous sections.

View Flow: 500v2 Flow X

r Criteria - Profile
Flow Name 500v2 Flow Signaling Interface Inside-Sig-40
Server Configuration IPO-500v2 CallServer : Inside-Media-
Media Interface Interface
URI Group *
Secondary Media Interface None
Transport *
End Point Policy Group enterprise policy
Remote Subnet *
Routing Profile To ATT IPFR.
Received Interface Cutside-B2-Signaling
s SIP-Trunk-
Topology Hiding Profile Topology

Signaling Manipulation Script  Mone

Remote Branch Office Any
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Once again, select the Server Flows tab and click Add. The following screen shows the flow
named IPFR flow viewed from the sample configuration. This flow uses the interfaces, polices,
and profiles defined in previous sections.

View Flow: IPFR flow X

- Criteria - Profile

Flow Mame IPFR flow : : Cutside-B2-

Signaling Interface Signaling
Server Configuration AT T-trk-svr

Media Interface Qutside-B2-Media
URI Group "

Secondary Media Interface Mone
Transport *

End Point Policy Group aft-policy-group
Remote Subnet *

Routing Profile To IPC 500v2
Received Interface Inside-Sig-40

- SIP-Trunk-

Topology Hiding Profile Topolcrrlgj;;

Signaling Manipulation Script  Mone

Remote Branch Office Any

7. AT&T IP Flexible Reach — Enhanced Features

Configuration

AT&T provides the IPFR-EF service border element IP address, the access DID numbers, and
the associated DNIS digits used in the reference configuration. In addition, the AT&T IPFR-EF
features, and their associated access numbers, are also assigned by AT&T.

8. Verification Steps

This section provides example verifications of the Avaya configuration with AT&T IPFR-EF
service.

8.1. Avaya SBCE
This section provides verification steps that may be performed with the Avaya SBCE.

8.1.1. Incidents

The Incident Viewer can be accessed from the Avaya SBCE Dashboard as highlighted in the
screen shot below.

Alarms  Incidents Status~ Logsv Diagnostics Users Settings~ Helpv Log Out
Session Border Controller for Enterprise AVAYA
Dashboard Dashboard

Adminisiraton —— s
Backup/Restore System Time 02:12:02 PM MST Refresh EMS
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Use the Incident Viewer to verify Server Heartbeat and to troubleshoot routing failures.

Incident Viewer AVAYA
Device | All ¥ | Category | All M Clear Filters | Refresh || Generate Report |
Displaying results 1 to 15 out of 2000.

Type 1D Date Time Category Device Cause

Server Heartbeat 732486352784935 6/3/16 10:51 AM Policy SBCA Heartbeat Successful, Server is UP
Server Heartbeat 732486352784497 6/3/16 10:51 AM Policy SBCH Heartbeat Successful, Server is UP
Server Heartbeat 732486352752785 6/3/16 10:51 AM Policy SBCH Heartbeat Successful, Server is UP
Server Heartbeat 732486352752361 6/3/16 10:51 AM Policy SBCH Heartbeat Successful, Server is UP

8.1.2. Server Status

The Server Status can be access from the Avaya SBCE Dashboard by selecting the Status
menu, and then Server Status.

Alarms  Incidents  Status v

Logsv Diagnostics Users

Settingsv Helpv Log Out

SIP Statistics
Session BUELEEEEEhtroller for Enterprise

Server Status

AVAYA

8.1.3. Tracing

To take a call trace, navigate to Device Specific Settings = Troubleshooting = Trace and
select the Packet Capture tab. Populate the fields for the capture parameters and click Start
Capture as shown below.

Session Border Controller for Enterprise AVAYA

> PP Services «  Trace: SBCE

> Domain Policies
> TLS Management

4 Device Specific Settings Packet Capture | | Captures
Network SBCE Packet Capture Configuration

Management

Status Ready

Media Interface

Signaling Interface Interface B2 v

End Paint Flows Local Address :
1PL All v

[:Port]

Session Flows

> DMZ Services Remote Address

TURN/STUN
Protocol UDP v

Service

SNMP Maximum Number of Packets to Capture 10000

Syslog Management
Capture Filename ¥ »
Using the name of an existing capture will ovenwite 1. protacol-trace-att. pcap

Advanced Options
4 Troubleshooting

Start Capture Clear

Debugging

Trace

DoS
Learning

65 of 73
IPO101SBC72FR

DDT; Reviewed:
SPOC 4/16/2018

Solution & Interoperability Test Lab Application Notes
©2018 Avaya Inc. All Rights Reserved.



When tracing has reached the desired number of packets the trace will stop automatically, or

alternatively, hit the Stop Capture button at the bottom.

> loDal Faramelers

> Global Profiles

» PPM Services

» Domain Policies

> TLS Management

< Device Specific Seftings

Network
Management

Media Interface
Signaling Interface
End Paint Flows
Session Flows

> DMZ Services

TURN/STUN
Service

SNMP
Syslog Management
Advanced Opticns

+ Trace: SBCE

SBCE

Session Border Controller for Enterprise

Packet Capture || Captures.

AVAYA

Status
Interface
Local Address
IP[:Port]

Remote Address
*, “Por, IP. IP:Port

Protocol
Maximum Number of Packets to Capture

Capture Filename
Using the name of an exi

of an existing capture will overwrits it

A packet capture is currently in progress. This page will automatically refresh until the capture completes.
Packet Capture Configuration

In Progress
B2 v

All

UDP ¥
10000

pratocol-trace-att. pcap

4 Troubleshooting Stop Capture
Debugging
Trace
Dos
Learning

Select the Captures tab to view the files created during the packet capture.

> lopal Faramerters
> Global Profiles

> PPM Services

> Domain Policies

> TLS Management

< Device Specific Setfings

Network
Management

Media Interface
Signaling Interface
End Point Flows
Session Flows

» DMZ Services

TURN/STUN
Service

SNMP
Syslog Management
Advanced Options
4 Troubleshooting
Debugging
Trace
DoS

+ Trace: SBCE

SBCE

Session Border Controller for Enterprise

File Name
protocoltrace-att_20161202095602. pcap

File Size (bytes)
45,066

AVAYA
Packet Capture | | Captures
Refresh

Last Modified
December 2, 2016 9:56:36 AM MST Delete

The packet capture file can be downloaded and then viewed using a Network Protocol Analyzer

like WireShark.
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8.2. IP Office
This section provides verification steps that may be performed with the IP Office.

8.2.1. System Status

The System Status application can be used to monitor or troubleshoot Avaya IP Office. The
System Status application can typically be accessed from Start - Programs > Avaya IP
Office = System Status. The following screen shows an example Logon screen. Enter the
Avaya IP Office IP address in the Control Unit IP Address field, and enter an appropriate User
Name and Password. Click Logon.

Online | offine

Logon

Control Unit IP Address: PLEEBTR]

Services Base TCP Port: Elf:Li]

Local IP Address: NGl

L BT L Admini strator

Password: |
Auto reconnect

Secure connection

Select Trunks - Line: 20 from the left navigation menu. (SIP Line 20 is configured in Section
5.4). A screen such as the one shown below is displayed. In the lower left, the Trace All button
may be pressed to display tracing information as calls are made using this SIP Line. The Ping
button can be used to ping the other end of the SIP trunk (e.g., Avaya SBCE).

IP Office System Status

AVAYA

Snapshot LogOff Exit About

Status  Utiization Summary

Alarms.

SIP Trunk Channel Licenses:
SIP Trunk Channel Licenses in Use:
SIP Device Features:

ite

SIP Trunk Summary
Line Service State: In Service
Peer Domain Name: 10.564.91.40
Resolved Address: 10.64.91.40
Line Mumber: 20
Number of Administered Channels: 20
Number of Channels in Use: 2}
Administered Compression: G729 A, G711 Mu
Enable Faststart: off
Silence Suppression: off
Media Stream: Best Effort
Layer 4 Protocol: s

= @
o

REFER (Incoming and Outgoing)

Time in State tion Caller ID or Other Party on Call

Receive R Transmit Transmit

Direction of Round Trip
Cal Delay

e Dialed Digits Call Jitter P .. Jditter Packet Lo...
1 Idle 00:33:27 ~
2 Ide 04:07:23
3 Ide 04:07:23
4 Ide 04:07:23
5 Ide 04:07:23
6 Ide 04:07:23
7 Ide 04:07:23
8 Ide 04:07:23
9 Ide 04:07:23
10 Ide 04:07:23
1 Idle 04:07:23
12 Idle 04:07:23 v
Trace Trace All Pause Ping Call Details Graceful Shutdown Force Out of Service Print... Save As...
3:41:51PM Online
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Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Help Snapshot LogOff Exit About

B system

B & Alarms (1)
Configuration (0)
Service (0}

B & Trunks (1)
Line: 5 (0)
Line: 6 (0)
Line: 7 (0)

Alarms for Line: 20 SIP 10.64.91.40
Alarms

Last Date Of Error Occurrences

Error Description

(0)
[ FLine: 20 (0

& Line: 22 (1)

8.2.2. Monitor

The Monitor application can also be used to monitor and troubleshoot IP Office. Monitor can be
accessed from Start - Programs > IP Office - Monitor. The application allows the
monitored information to be customized. To customize, select Filters = Trace Options.

The following screen shows the SIP tab, allowing configuration of SIP monitoring. In this
example, the SIP Rx and SIP Tx boxes are checked. All SIP messages will appear in the trace
with the color blue. To customize the color, right-click on SIP Rx or SIP Tx and select the
desired color.

All Settings X
T1 | wComp | wPM | wen | soN | sSI | Jade
ATM | cal | DTE | EConf | FrameRelay | GOD | H323 | Interface
ISDM ] KeyLamp ] Directory ] Media ] FPP ] R2 ] Flouling] Services  SIP lSystem

Ewvents
I Sip [Terse I+ STUN [~ SIP Dect
Packets
[ SIP Reg/Opt Ax [~ SIP Mizc Ax
[~ SIP Reg/Opt Tx [ SIP Misc Tx
[~ SIP Call A= [~ Cm Motify A=
[~ SIPCall Tx [~ Cm Motify T
v SipRx [~ hex |F Filter [nnn.nnn.nnn.nnn)
[v SipTx [~ hex
Default Al | Clearal |  Tabllearsil| Tabseta| Cancel
SaveFle | LoadFie | LoadParialFie|  SelotFie |
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As an example, the following shows a portion of the monitoring window for an outbound call
from extension 322, whose DID is 303-555-9322, calling out to the PSTN via the AT&T IPFR-
EF service. The telephone user dialed 9-303-555-1234.

&) Avaya IP Office SyshMonitor - Monitoring 10.64.12.70 (SIL-ATT); Log Settings - C:\Users\...\sysmonitorsettings.ini - O X
File Edit View Fiters Status Help

=E| »(8IT| X[V @ ¥lE=m

15:48:53  15314590mS RESS5: CLog MemOb]s=343 FreePoolMem(Objs)=2964(57) TotalMem=20800 StringsTotalMem=103600 ~

sxxxaxsxss SysMonitor v10.1.0.1.0 build 3 [connected to 10.64.19.70 (SIL-ATT)] ***ssssssx
15324143mS PRN: Monitor Status IP 500 V2 10.1.0.1.0 build 3
15324144mS PRN: LAW=U PRI=0, BRI=0, AL 4, W 10, MODM=0, WAN=0, MODU=0 LENM=0 CEKSRC=0 VMAIL=1(VER=3 TYP=1) 1-X=1 CALLS=0(I0T=11)
15:49:03  15324626mS SIF Rx: TLS 10.64.91.40:55281 -> 10.64.13.70:5061

INVITE sips:3035559322810.64.19.70:5061 SIB/2.0

From: "3035551234" ips:3035551234@10.64.91.40;user-phone>; tag=1198591364-1519771744994—

T "User 3035559322" <s8ips:3035559322@10.64.19.70:5061;user=phone>

CSeq: 750402930 INVITE

Call-ID: EcSafe32lale794443899bicT2e52148

Contact: <sips:10.64.91.40:5061;transport=tls>

Record-Route: <sip:10.64.91.40:5061;ipcs-1ine=173354; lr;transpore=cls>

Allow: INVITE,ACK,CANCEL,BYE, REFER, INFO, NOTIFY, PRACK, OPTIONS

Supported: timer, replaces

Max-Forwards: €7

Via: SIB/2.0/TLS 10.64.91.40:5061;branch=z9nG4b¥-51632-001967047307-1--51632~

Lecepn: application/demf-relay, application/media control+sml, application/sdp, multipart/mixed

Privacy: none

P-Asserted-Identity: "3035551234" <sips:3035551234€10.64.91.40;user=phone>

Session-Expires: 1800;refresher=uac

Min-SE: 60

Content-Disposition: session; handling=required

Content-Type: application/sdp

Recv-Info: x-broadworks-clienc-session-info

Content-length: 398

=0
o=BroadWorks £21337717 1 IN IP4 10.64.91.40
a=

c=IN IP4 10.64.91.40

t=0 0

meaudic 16750 RTE/AVE 12 0 100

a=ripmap:1i G728/8000

a=rtpmap:0 BCMO/2000]

a=rtemap:100 telephone-event/S000
a=fmep:100 0-15

a=sendrecv

a=maxptime:30

a=prime:20

a=tcap:l RIE/SEVE

15:49:03 15324630m5 0000000000000000 0.1035.0 -1 BaseEP: NEW CMEndpoint £1779648 TOTAL NOW=1 CALL_LIST=0
15:49:03  15324431mS Stun: Line 20: Not using SION for media in this case
15:49:03  15324634mS SIP Tx: TLS 10.64.19.70:5061 —> 10.64.91.40:55891
SIP/2.0 100 Trying
Via: SIB/2.0/TLS 10.64.91.40:5061;branch=29hG4bK-51632-001967047307-1--31632~
Record-Route: <sip:10.64.91.40:5061;ipca-1ine=173354; lr;transport=tlax
From: "3035551234" <sips:3035551234610.64.91.40;user=phone>; tag=1198591364-1519771744994-
Call-ID: BcS5abe381ale794443899b4cT72e5al48
CSeq: 750402930 INVITE
Allow: INVITE,ACK,CANCEL, OPTIONS,BYE, INFO, REFER, NOTIFY v
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9. Conclusion

As illustrated in these Application Notes, Avaya IP Office Release 10.1 and the Avaya Session
Border Controller for Enterprise 7.2 can be configured to interoperate successfully with the
AT&T IP Flexible Reach - Enhanced Features service using AVPN or MIS/PNT transport
connections, within the limitations described in Section 2.2.

The reference configuration shown in these Application Notes is representative of a basic
enterprise customer configuration and is intended to provide configuration guidance to
supplement other Avaya product documentation. It is based upon formal interoperability
compliance testing as part of the Avaya DevConnect Service Provider program.

10. Additional References

This section references documentation relevant to these Application Notes. In general, Avaya
product documentation is available at http://support.avaya.com

[1] IP Office ™ Platform 10.1, Deploying Avaya IP Office Servers as Virtual Machines,
Document Number 15-601011, Issue 05j, November 2017

[2] Administering Avaya IP Office ™ Platform with Manager, Release 10.1, July 2017

[3] IP Office ™ Platform 10.1, Deploying Avaya IP Office ™ Platform IP500 V2, Document
Number 15-601042, Issue 32I, December 2017

[4] IP Office ™ Platform 10.1, Using Avaya IP Office ™ System Status, Document Number
15-601758, Issue 12d, July 2017

[5] IP Office ™ Platform 10.1, IP Office SIP Phones with ASBCE, Issue 02b, July 2017

[6] Deploying Avaya Session Border Controller in Virtualized Environment, June 2017

[7] Administering Avaya Session Border Controller for Enterprise, February 2018

[8] RFC 3261 SIP: Session Initiation Protocol http://www.ietf.org/rfc/rfc3261.txt

Additional IP Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

11. Appendix 1 — Multiple AT&T Border Elements

AT&T may provide two network border elements for redundancy purposes. The Avaya SBCE
can be provisioned to support this redundant configuration.

Given two AT&T border elements 192.168.38.69 (Primary) and 192.168.37.149 (Secondary), the
Avaya SBCE is provisioned as follows to include the backup trunk connection.
Step 1 — Edit the existing AT&T Server Configuration

1. Select Global Profiles = Server Configuration from the left-hand menu.

2. Select AT&T profile created in Section 6.6.2 (e.g., ATT-trk-srv)

3. Click Edit (not shown)

4. On the Edit Server Configuration Profile — General tab, click Add and enter

the following:
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- IP Address / FQDN: 192.168.37.149 (Address for a secondary

location)
- Port: 5060
- Transport: UDP
Select Finish
Edit Server Configuration Profile - General X
Server Type can not be changed while this Server Configuration profile is associated to a Server
Flow.
Server Type Trunk Server v
SIP Domain
TLS Client Profile None v
Add
IP Address [ FQDN Port Transport
192.168.38.69 5060 UDP v | Delete
192.168.37.149 5060 UppP v | Delete
Finish
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Step 2 - Add Secondary IP Address to Routing.

1. Select Global Profiles = Routing from the left-hand menu.

2. Select the Routing Profile created in Section 6.4.6 (e.g., ATT_IPFR)

3. Click Edit (not shown)
4. Click Add and enter the following:
a) Priority/Weight: 2
b) Server Configuration: ATT_trk_srv

c) Next Hop Address: Select 192.168.37.149:5060 (UDP) from the drop-down

menu.
5. Click on Finish.

Mext Hop In-Dialog

ENUM ENUM Suffix

Add
Priority / Weight ~ Server Configuration Next Hop Address Transport
1 AT T-rk-svr v 192.168.38.69:5060 (UDP) v MNone v | Delete
2 AT T-rk-svr v 192.168.37.149:5060 (UDP) v MNone v | Delete

Profile : To ATT IPFR - Edit Rule X
URI Group |:| Time of Day default ¥
Load Balancing Priority v NAPTR
Transport None v Next Hop Priority v

Ignore Route Header

Finish

Note — If desired, the Load Balancing parameter may be used to modify how the two defined
AT&T Border Elements are accessed. Priority was used in the Reference Configuration.

When completed the Avaya SBCE will issue OPTIONS messages to the primary
(192.168.38.69) and secondary (192.168.37.149) border elements. If the SBCE fails to get a
response to the OPTIONS sent to 192.168.38.69, the SBCE will direct outbound calls to

192.168.37.149.
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are the property of their respective owners. The information provided in these Application
Notes is subject to change without notice. The configurations, technical data, and
recommendations provided in these Application Notes are believed to be accurate and
dependable, but are presented without express or implied warranty. Users are responsible for
their application of any products specified in these Application Notes.

Please e-mail any questions or comments pertaining to these Application Notes along with the
full title name and filename, located in the lower right corner, directly to the Avaya
DevConnect Program at devconnect@avaya.com.
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